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1. About the Drive-On-Chip Design Example for Cyclone V
Devices

The design demonstrates concurrent multiaxis control of two three-phase permanent
magnet synchronous motors (PMSMs) or sinusoidally wound brushless DC (BLDC)
motors.

The design targets a Cyclone V SoC development board. The board can take power
from a standard power supply or from a rechargeable battery pack, which shows the
bidirectional power flow and battery state-of-charge estimation features.

AC and servo drive system designs comprise multiple distinct but interdependent
functions to realize requirements to meet the performance and efficiency demands of
modern motor control systems. The system's primary function is to efficiently control
the torque and speed of the AC motor through appropriate control of power
electronics. A typical drive system includes the following items:

• Flexible pulse-width modulation (PWM) circuitry to switch the power stage
transistors appropriately

• Motor control loops for single- or multiaxis control

• Industrial networking interfaces

• Position encoder interfaces

• Current, voltage, and temperature measurement feedback elements.

• Monitoring functions, for example, for vibration suppression.

The system requires system software running on a processor for high-level system
control, coordination, and management.

Cyclone® devices offer high-performance fixed- and floating-point DSP functionality.
Cyclone V SoC devices offer the integrated ARM-based hard processor subsystem
(HPS). Cyclone FPGA devices offer a scalable and flexible platform for integration of
single- and multiaxis drives on a single FPGA. The Intel motor control development
framework allows you to create these integrated systems easily. The framework
provides a design that comprises IPs, software libraries, and a hardware platform. The
framework seamlessly integrates Intel system-level design tools such as DSP Builder
and Qsys, and software and IP components that allow you to extend and customize
the design to meet your own application needs. The framework also supports optimal
partitioning decisions between software running on an integrated processor and IP
performing portions of the motor control algorithm in the FPGA, to accelerate
performance as required. For example, depending on the performance requirements of
your system or the number of axes you need to support, you may implement all the
inner current control loop in hardware or entirely in software. The framework flexibly
allows you to connect to the motor and power stages through off-chip ADCs, and
feedback encoder devices and to connect to higher-level automation controllers
through off-the-shelf digital encoder and industrial Ethernet IP cores, respectively.
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The design offers vibration suppression. The design demonstrates how you can
implement standard components (FFTs, FFT-post processing, IIR filter), to enable you
to develop an automatic method for vibration suppression. You may use the FFTs and
FFT postprocessing for condition monitoring, which detects vibrations that indicate
degradation or wear and communicate the results to another system.

The design integrates Motor Control IP Suite components, an ARM-based HPS, and
software that uses an FOC algorithm. The design uses the Intel DSP Builder system-
level design tool to implement the FOC algorithm.

DSP Builder provides a MATLAB and Simulink flow that allows you to create hardware
optimized fixed latency representations of algorithms without requiring HDL/hardware
skills. Intel provides DSP Builder fixed-point and floating point algorithms to
demonstrate both options. The DSP Builder folding feature reduces the resource usage
of the logic as an alternative to a fully parallel implementation. The design also
includes an efficient Avalon® Memory-Mapped interface that you can integrate in Qsys.

Related Information

• Tandem Motion-Power 48 V Board Reference Manual

• Cyclone V SoC Development Kit

• Battery Management System Reference Design
The Battery Management System (BMS) Reference Design demonstrates
battery state of charge (SOC) estimation in an FPGA-based real-time control
platform that you can extend to include other BMS functionality such as battery
state-of-health monitoring and charge equalization (cell balancing).

1. About the Drive-On-Chip Design Example for Cyclone V Devices
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2. Motor Control Boards
Table 1. FPGA Host Control Board Options

Board Vendor Website

Cyclone V SoC development board Intel https://www.intel.com/content/www/us/en/products/details/fpga/
development-kits/cyclone/v-sx.html

Table 2. Motor Control Power Board

Board Vendor Power Stage Sample Rate (kHz max) Supported Feedback

Tandem Motion- Power 48 V
Board

Terasic MOSFET 125 Quadrature encoder, resolver,
sensorless, trapezoidal

An HSMC connector connects the Cyclone V SoC development board to the Tandem
Motion- Power 48 V Board

Related Information

Terasic Website
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3. Drive-On-Chip Design Example for Cyclone V Devices
Features

• Multiple field-oriented control (FOC) loop implementations:

— Fixed- or floating-point implementation targeting the ARM Cortex A9 processor
on SoC devices

— Fixed and floating-point accelerator implementations designed using Simulink
model-based design flow with DSP Builder

• Integration in a single FPGA of a multiaxis motor control IP including:

— PWM for two-level inverter

— Sigma delta ADC interfaces for motor current feedback and DC link voltage
measurement

— Position feedback with quadrature encoder, Hall sensor, or sensorless

• Vibration suppression:

— DSP Builder-designed FFT accelerator

— Peak detection

— Suppression filter

• System Console GUI for motor feedback information, vibration suppression
demonstration, and control of motors

• Optional support for rechargeable battery power and BMS development with state-
of-charge estimation using an adaptive Dual Extended Kalman Filter (DEKF)
algorithm
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4. Getting Started
Software Requirements for the Drive-On-Chip Design Example for Cyclone V Devices
on page 8

Downloading and Installing the Drive-On-Chip Design Example for Cyclone V Devices
on page 8

Setting Up the Motor Control Board with your Development Board on page 10

Programming the Hardware onto the Device on page 11

Setting Up Terminal Emulator on page 11

Downloading the HPS Software to the Device on page 12

4.1. Software Requirements for the Drive-On-Chip Design Example
for Cyclone V Devices

The design requires:

• The Intel Quartus Prime Design Suite version 17.0.2, which includes:

— Intel Quartus Primte Standard Edition

— DSP Builder for Intel FPGAs

• The Intel SoC EDS v17.0

• Arm Development Studio

• Terminal emulator such as Tera Term or PuTTY

4.2. Downloading and Installing the Drive-On-Chip Design Example
for Cyclone V Devices

1. Download the DOC_TANDEM_CVSX.par file for your development kit and power
board from the Intel Design Store.

2. Install the relevant reference design DOC_TANDEM_CVSX.par file for your
development kit and power board.

3. In the Quartus II software, click File ➤ New Project Wizard.

4. Click Next.

5. Enter the path for your project working directory and enter
DOC_TANDEM_CVSX.par for the project name.

6. Click Next.

7. Select Project Template.

8. Click Next

9. Click Install the design templates.
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10. Browse to select the .par file for the design and browse to the destination
directory where you want to install it.

Figure 1. Design Template Installation

11. Click OK on the design template installation message.

12. Select the Drive on Chip Reference design design example.

Figure 2. Design Template

13. Click Next.

14. Click Finish. The Quartus II software expands the archive and sets up the project,
which may take some time.

Related Information

Intel Design Store

4. Getting Started
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4.3. Setting Up the Motor Control Board with your Development
Board

Caution: Before you begin, to prevent damage to the motor control board, ensure development
board and power board are turned off.

1. Remove the SD card from the SoC board if it is fitted.

2. Connect the power board to the development board using the HSMC connector.

3. Connect a USB cable from the USB-Blaster connector (J37) on the development
board to your computer. The Cyclone V SoC development board requires an
additional USB cable connected to the UART connector (J8).

4. Open the terminal emulator to connect to the virtual COM port (which has a large
number, e.g. 12) with:.

• Baud rate: 115000

• Data: 8 bit

• Parity: none

• Stop bits: 1

• Flow control: none

5. Apply power to the development board.

To power the board from a battery, refer to AN 773: Drive-On-Chip Design
Example for Intel MAX 10 Devices

• Preparing the Rechargeable Battery

• Setting Up the Motor Control Board with your Development Board for the
Drive-On-Chip Design Example for Intel MAX 10 Devices

• Applying Power to the Power Board

6. Compile the hardware and software and program the hardware and software to
the development board:

The terminal must display the correct FPGA and power boards, otherwise you
might damage either board.

7. Apply power to the motor control power board.

8. Before reprogramming the FPGA, or removing power from the development
boards, always remove power from the motor control power board first.

Related Information

• Cyclone V SoC Development Board Reference Manual
For information on setting up the Cyclone V SoC Development Board

• Tandem Motion-Power 48 V Board Reference Manual

• Preparing the Rechargeable Battery

• Setting Up the Motor Control Board with your Development Board for the Drive-
On-Chip Design Example for Intel MAX 10 Devices

• Applying Power to the Power Board

4. Getting Started
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4.4. Programming the Hardware onto the Device

1. In the Intel Quartus Prime software, click Tools > Programmer.

2. In the Programmer pane, select USB-Blaster II under Hardware Setup and
JTAG under Mode.

3. Click Auto Detect to detect devices.

4. Select 5CSXFC6D6 device from the pop-up list.

5. Double-click on the File field for the 5CSXFC6D6 device from the pop-up list.

6. Select the output_files/DOC_TANDEM_CVSX.sof and click Open.

7. Turn on Program/Configure for 5CSXFC6D6F31.

8. Click Start.

Related Information

Setting Up the Motor Control Board with your Development Board on page 10

4.5. Setting Up Terminal Emulator

You can choose any terminal emulators you are familiar with, for example PuTTY

1. Open PuTTY.

2. Setup Serial line: COM4, Speed: 115000

4. Getting Started
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Figure 3. Set Up PuTTY

3. Click Open.
After running the software, all the information displays.

4.6. Downloading the HPS Software to the Device

You can download the software with either the ARM DS GUI (suitable for beginners) or
script (suitable for advanced users).

Downloading the HPS Software with the Arm GUI on page 12

Downloading the HPS Software with the Arm Script on page 14

4.6.1. Downloading the HPS Software with the Arm GUI

You must have an Arm Development Studio license to download the HPS software.
Alternatively you can download the software with the Arm script.

1. Run SoC EDS command shell by typing the following command:

"<your_ArmDS_install_path_in_Cygwin_expresstion>/bin/
cmdsuite.exe"

For example: "/cygdrive/c/Program\ Files/Arm/Development\ Studio\
2021.1/bin/cmdsuite.exe"

2. Type the following command in the SoC EDS command shell:

4. Getting Started
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"armds_ide&"

The Arm Development Studio IDE Launcher opens.

3. Browse to <project_dir>/software, click Select Folder, then click Launch.

4. Select Run ➤ Debug Configurations.

Figure 4. Connection Tab

5. Create a new debugger configuration by double clicking Generic Arm C/C++
Application

6. On the Connection tab, select Debug Cortex-A9_0 under Intel SoC FPGA|
Cyclone V SoC (Dual Core)|Bare Metal Debug.

7. In the Target Connection drop-down select USB-Blaster and for Clock speed
select 20MHz.

8. In the Bare Metal Debug Connection field, click Browse… and select the USB
Blaster II on localhost.

9. Select the Debugger tab.

10. In Run Control, select Connect Only.

11. Turn on Run debug initialization debugger script (.ds / .py).

4. Getting Started
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12. Click File system to select the following file <project_dir>\software
\DOC_TANDEM_CVSX\src\DriveOnChip\debug.ds, then click Open.

13. In Host working directory turn on Use default .

14. Click Apply to save the configuration, optionally specifying a name for the new
configuration.

15. Click Debug.

16. Click Continue in the Debug Control panel to run the application.

17. Check that the terminal console display shows the correct FPGA and power board
combination. For example:

[DECODE SYSID] Decoding hardware platform from QSYS SYSID data : 0x004042FE
[DECODE SYSID] SYSID_VERSION_MAJOR : 0x04
[DECODE SYSID] SYSID_VERSION_MINOR : 0x00
[DECODE SYSID] SYSID_POWERBOARD_ID : 0x04
[DECODE SYSID] SYSID_DEVICE_FAMILY : 0x02
[DECODE SYSID] SYSID_DESIGN_ID     : 0xFE
[DECODE SYSID] Hardware design version: 4.0
[DECODE SYSID] FPGA Board     : Cyclone V SX Dev Kit
[DECODE SYSID] Power Board    : Intel Tandem Motion Power
[DECODE SYSID] Power board has 2 axes available
[DECODE SYSID] Axis 0         : Enabled
[DECODE SYSID] Axis 1         : Enabled 

18. Apply power to the power board when you see the following message in the
terminal console:

---> DC input voltage error - Check power connection

The motor starts to turn.

19. When the application is running, right-click on Cortex-A9_0 and click
Disconnect from Target.

4.6.2. Downloading the HPS Software with the Arm Script

You must have an Arm Development Studio license to download HPS software.
Alternatively you can download the software with the Arm GUI.

1. Run SoC EDS command shell.

2. Type the following commands in the SoC EDS command shell:

<your_ArmDS_install_path_in_Cygwin_expresstion>/bin/
cmdsuite.exe

For example:/cygdrive/c/Program\Files/Arm/Development\ Studio\
2021.1/bin/cmdsuite.exe

3. Type bash.

4. Type:

cd <project_dir>/software/armds_download_scripts

5. Type ./download.sh ../DOC_TANDEM_CVSX/doc_tandem_cvsx.axf.

6. Check that the terminal console display shows the correct FPGA and power board
combination .

7. Apply power to the power board when you see

“---> DC input voltage error - Check power connection.

4. Getting Started
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The motor starts to turn.

4. Getting Started

683466 | 2022.05.15

Send Feedback AN 669: Drive-On-Chip Design Example for Cyclone V Devices

15

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20AN%20669:%20Drive-On-Chip%20Design%20Example%20for%20Cyclone%20V%20Devices%20(683466%202022.05.15)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


5. Building the Design

5.1. Compiling the Drive-on-Chip Design Example

1. Generate the Qsys System:

a. In the Qsys software click File ➤ Save.

b. Click Generate HDL….

c. Click Generate.

d. Click Close. If your changes result in new exported connections you can view
the Qsys component template by clicking Generate ➤ Show Instantiation
Template….

e. Add new ports to the Qsys component instantiation in the top level RTL of the
project <project variant>.v.

f. Close Qsys.

2. After changing the Qsys system, regenerate system.h:

In a Nios II Command Shell:

a. Run Nios II command shell from Windows start menu:Intel FPGA…/Nios II
Command Shell.

b. Type cd <project_dir>.

c. Type make system.h. The system.h file generates in ./ software/
DOC_TANDEM_CVSX/src/DriveOnChip/ directory.

3. Compile the .sof in the Intel Quartus Prime Software; click Processing ➤ Start
Compilation.

5.2. Preparing the µC/OS-II HPS Software Files

To complete the software files for the Drive-on-Chip Design Example, you need to
download the uC/OS II files from the Micrium web site, then construct the software
directory structure with a script provided with the design archive.

1. Start a web browser and go to the Weston Embedded website.

2. Launch SoC EDS command shell.

3. Go to the micrium-examples page by selecting MICRIUM ➤ EXAMPLES from the
upper menu.

4. Search de10-nano_webserver and click the download link.

5. Change the current directory to software\Setup in the command shell by typing
cd <project_dir>/software/Setup.

6. Type mkdir Micrium_files; cd Micrium_files .
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7. Type git clone https://github.com/weston-embedded/uC-CPU.git.

If you see this error, fatal: unable to access …: error setting
certificate verify locations …, type git config --global
http.sslCAInfo /usr/ssl/certs/ca-bundle.crt.

The software creates the uC-CPU directory under the current folder.

8. Type git clone https://github.com/weston-embedded/uC-LIB.git.

9. Type git clone https://github.com/weston-embedded/uC-OS2.git.

10. Download the DE10 Nano webserver example design from the Weston Embedded
website.

a. Register and login.

b. Access the DE10 Nano web page.

c. Right click Download, and select Save link as....

d. Navigate to <project_dir>/software/Setup/Micrium_files directory ,
and save the file as de10-nano_webserver.zip.

11. Change the current directory to the software\Setup directory in the command
shell by typing cd <project_dir>/software/Setup .

12. Run the script to integrate software files.

13. Type source setup_software_files.sh.

Table 3. Software Project Directories
The table shows the software project directories in the <project_dir>/software/DOC_TANDEM_CVSX/
directory.

Directory Description

hwlibs The build process copies selected files from the Intel Quartus Prime Design Suite
hardware libraries to this directory.

objects The build process creates object files here.

src\Micrium Real time operating system.

src\DriveOnChip\bms Battery management system. (SOC estimation.)

src\DriveOnChip\components Motor control component source and header files.

src\DriveOnChip\mc Motor control source and header files.

src\DriveOnChip\motorsim Motor simulation model, not applicable for this design.

src\DriveOnChip\perf Performance monitor source and header files.

src\DriveOnChip\platform Platform (development kit and RTOS) specific source and header files.

src\DriveOnChip\waveform Waveform generation for motor control.

Related Information

Weston Embedded website

5.3. Compiling the µC/OS-II HPS Software

You can compile the software with either the Arm Development Studio GUI (suitable
for beginners) or script (suitable for advanced users).

5. Building the Design
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Compiling the µC/OS-II HPS Software with the Arm GUI on page 18

Compiling the µC/OS-II HPS Software with the Arm Script on page 18

5.3.1. Compiling the µC/OS-II HPS Software with the Arm GUI

You must have an Arm Development Studio license to compile the HPS software.
Alternatively you can compile the software with the Arm script.

1. Run the SoC EDS command shell.

2. In the SoC EDS command shell, type
<your_ArmDS_install_path_in_Cygwin_expresstion>/bin/
cmdsuite.exe, for example:

/cygdrive/c/Program\Files/Arm/Development\ Studio\ 2021.1/bin/
cmdsuite.exe

3. Set default toolchain environment by typing select_toolchain, then enter the
number for Arm Compiler 6.

4. In the SoC EDS command shell, type armds_ide&.
The Arm Development Studio IDE Launcher opens.

5. Browse to <project_dir>/software, click Select Folder, then click Launch.

6. Click Finish to close the preferences wizard.

Note: Close the welcome to Development Studio tab if it shows.

7. Import the makefile project DOC_TANDEM_CVSX:

a. Select File > Import to open the Import window.

b. Select General > Existing Projects into Workspace and click Next.

c. Click Select Root Directory and browse to the project directory,
DOC_TANDEM_CVSX in the workspace directory, DOC_TANDEM_CVSX.

d. Click OK.

e. Click Finish.

8. Rebuild the DOC_TANDEM_CVSX project: right-click DOC_TANDEM_CVSX
project and click Build Project.

5.3.2. Compiling the µC/OS-II HPS Software with the Arm Script

You must have an Arm Development Studio license to compile the HPS software.
Alternatively you can compile the software with the Arm GUI.

1. Run the SoC EDS command shell.

2. In the SoC EDS command shell, type
<your_ArmDS_install_path_in_Cygwin_expresstion>/bin/
cmdsuite.exe, for example:

/cygdrive/c/Program\Files/Arm/Development\ Studio\ 2021.1/bin/
cmdsuite.exe

3. Set default toolchain environment by typing select toolchain and then enter
the number Arm Compiler 6.

4. Type cd <project_dir>/software/DOC_TANDEM_CVSX.

5. Building the Design
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5. Type bash.

6. Type export ARM_TOOL_VARIANT=intel_fpga.

7. Type make.

5.4. Creating and Booting an HPS SD Card Software Image

You create a bootable SD card that contains the software image, so you can boot the
software automatically without using the Arm Development Studio Debugger.

1. Create a bootable SD card image using the prebuilt image that the SoC EDS
includes.

a. On Windows, download and install an SD card image writing utility, for
example balenaEtcher or win32diskimager.

b. Find the bootable image for your development board.

For the Cyclone SoC development board find CycloneV_Linux_SDCard.img
in the Intel SoC EDS default installation directory: C:\intelFPGA
\17.0\embedded\embeddedsw\socfpga\prebuilt_images
\CycloneV_Linux_SDCard.tar.gz

c. Launch SOC EDS Command Shell as an administrator, and change the current
directory to the prebuilt_images directory by typing:

cd ‘C:\intelFPGA\17.0\embedded\embeddedsw\socfpga
\prebuilt_images’

d. Untar the compressed image file by typing:.

tar -xf CycloneV_Linux_SDCard.tar.gz

e. Write the bootable image, CycloneV_Linux_SDCard.img, with your SD card
image writing utility on Windows or dd command on Linux onto your SD card.

2. Update the preloader with the binary image made from the Drive-On-Chip design.

a. Type cd <project_dir>/software/spl_bsp in the SoC EDS command
shell.

b. Write the preloader image into the proper location in your SD card by typing:

alt-boot-disk-util -p preloader-mkpimage.bin -a write -d
<sdcard_drive_letter> .

Where <sdcard_drive> is the drive your SD card appears as on your
computer.

3. Copy doc_tandem_cvsx.bin to the FAT partition on the SD card.

4. Enter U-Boot:

a. Unmount the SD card from PC, then insert the SD card in the board

b. Open your Terminal Emulator software and connect to the board.

c. Apply power to the board.

d. Press a key in the terminal window when prompted, before the countdown
finishes and the operating system boots.

5. At the U-Boot prompt, edit the U-Boot environment by typing:

5. Building the Design
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setenv mmcload "mmc rescan;fatload mmc 0:1 0x01000000
doc_tandem_cvsx.bin ;go 0x01000000"

6. Save the new environment setting by typing:

env save

7. Configure the FPGA.

8. Boot the software: press Cold Reset on the development boards again.

Related Information

• Programming the Hardware onto the Device on page 11

• Windows Disk Imager

5.5. Creating and Booting a SD Card with both Software Image and
Hardware Image

You create a bootable SD card that contains both the software image and hardware
image, so you can boot the software automatically without using the Arm
Development Studio Debugger and you do not need to program the FPGA every single
time.

1. Create a bootable SD card image using the prebuilt image that the SoC EDS
includes.

a. On Windows, download and install an SD card image writing utility, for
example balenaEtcher or win32diskimager.

b. Find the bootable image for your development board.

For the Cyclone SoC development board find CycloneV_Linux_SDCard.img
in the Intel SoC EDS default installation directory: C:\intelFPGA
\17.0\embedded\embeddedsw\socfpga\prebuilt_images
\CycloneV_Linux_SDCard.tar.gz

c. Launch SOC EDS Command Shell as an administrator, and change the current
directory to the prebuilt_images directory by typing:

cd ‘C:\intelFPGA\17.0\embedded\embeddedsw\socfpga
\prebuilt_images’

d. Untar the compressed image file by typing:.

tar -xf CycloneV_Linux_SDCard.tar.gz

e. Write the bootable image, CycloneV_Linux_SDCard.img, with your SD card
image writing utility on Windows or dd command on Linux onto your SD card.

2. Update the preloader with the binary image made from the Drive-On-Chip design.

a. Type cd <project_dir>/software/spl_bsp in the SoC EDS command
shell.

b. Write the preloader image into the proper location in your SD card by typing:

alt-boot-disk-util -p preloader-mkpimage.bin -a write -d
<sdcard_drive_letter> .

5. Building the Design
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Where <sdcard_drive> is the drive your SD card appears as on your
computer.

3. On the Cyclone V SoC development board, set SW3 (MSEL) to ON-OFF-ON-OFF-
ON (0:Up, 1:Down, 2:Up, 3:Down, 4:Up)

4. Open a Nios II command window, go to <project_dir>\output_files by
typing:

cd <project_dir>\output_files

5. Generate soc_system.rbf from DOC_TANDEM_CVSX.sof by typing this
command in the Nios II command window.

quartus_cpf -c -o bitstream_compression=on DOC_TANDEM_CVSX.sof
soc_system.rbf

6. Copy soc_system.rbf to the FAT partition on the SD card.

7. Copy doc_tandem_cvsx.bin from the <project_dir>\software
\DOC_TANDEM_CVSX to the FAT partition on the SD card.

8. Enter U-boot

a. Unmount the SD card from PC, then insert the SD card in the development
board.

b. Open your Terminal Emulator software and connect to the USB serial port on
the development board.

c. Apply power to the development board.

d. Press a key in the terminal window when prompted, before the countdown
finishes and the operating system boots.

9. At the U-Boot prompt, edit the U-Boot environment variables and save them by
typing:

setenv fpgaconfig 'fatload mmc 0 $fpgadata $fpgarbffile; fpga
load 0 $fpgadata $filesize; run bridge_enable_handoff'

setenv fpgarbffile soc_system.rbf

setenv docload 'fatload mmc 0 1000000 doc_tandem_cvsx.bin'

setenv bootcmd 'run fpgaconfig; run docload; go 1000000'

saveenv

10. Power cycle the development board or reset by pushing Cold reset push button
(S7). In the terminal window you will see the sequence: U-Boot starts to count
down, then FPGA is configured and the DriveOnChip software is downloaded and
started.

5. Building the Design
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Figure 5. Application starts-up

11. Apply power to the power board when you see this message in terminal console

---> DC input voltage error - Check power connection.

Figure 6. Application is ready for power board powered-up

The motor starts to turn.

5. Building the Design
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6. Debugging and Monitoring the Drive-On-Chip Design
Example with System Console

1. In the Intel Quartus Prime software, click Tools > System Debugging Tools >
System Console.

2. In Tcl console type toolkit_register toolkits/doc_toolkit/
DOC.toolkit and press enter.

3. In the Drive On A Chip Debug GUI area, click Launch.

4. Check that the console display shows the correct FPGA and power board
combination. For example for the Tandem Motion-Power 48 V Board project
variant look for the following lines:

Version = 4.0  Device Family = 2 Powerboard Id = 4 Design Id = 254 
FPGA Board     : Cyclone V SX on Intel dev kit
Power Board    : Intel Tandem 48V 

You can right-click on the Drive On A Chip Debug GUI tab and select Detach to
display the GUI in its own window. Close the window to reattach it to the
System Console window.

A number of tabs are populated in the Drive-On-A-Chip Debug GUI, depending on the
project variant. The tabs are grouped into two panes. Use the upper pane, starting
with the Data Source tab to configure the design. Use the lower pane, starting with
the General tab to start demonstrations and monitor the state of the design.

System Console GUI Upper Pane for the Drive-On-Chip Design Example on page 24

System Console GUI Lower Pane for the Drive-On-Chip Design Example on page 25

Vibration Suppression Tab on page 29

Controlling the DC-DC Converter on page 32

Tuning the PI Controller Gains on page 32

Controlling the Speed and Position Demonstrations on page 33

Monitoring Performance on page 33
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6.1. System Console GUI Upper Pane for the Drive-On-Chip Design
Example

Trace Setup Tab

On the Trace Setup tab setup select:

• The waveform tracing by specifying a trigger

• Axis to trace

• Trace depth

• A filename to store the trace data.

Click Update Trigger after making any changes. Click Start Trace to start tracing.
See the Waveform tab for trace display. When saving trace data to a file, be aware
that the design overwrites the file with each trace; it does not append new traces to
an existing file.

Figure 7. Trace Setup Tab

Current Control Tab

On the Current Control tab, enter the P (Kp) and I (Ki) coefficients for the current
control loop. These quantities are preset to the correct values for the motor type
configured in the application software. Click Update Parameters after making a
change.

Figure 8. Current Control Tab

Speed Control Tab

On the Speed Control tab, enter the P (Speed Kp) and I (Speed Ki) coefficients for
the speed control loop. These quantities are preset to the correct values for the motor
type configured in the application software. Click Update Parameters after making a
change.

Figure 9. Speed Control Tab

Position Control Tab

On the Position Control tab, enter the P (Position Kp) coefficient for the position
control loop. This quantity is preset to the correct values for the motor type configured
in the application software. Click Update Parameters after making a change.

6. Debugging and Monitoring the Drive-On-Chip Design Example with System Console
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Figure 10. Position Control Tab

Sensorless Control Tab

On the Sensorless Control tab, enter the Hys Gain (Hysteresis control gain), Damp
Coeff (damping coefficient), natural freq (natural frequency) and Hys Thld (Hysteresis
threshold) values for the sensorless control loop. These quantities are preset to the
correct values for the motor type configured in the application software. Click Update
Parameters after making a change. Modifying these four control parameters may
cause the system to become unstable. For example, the motor speed may oscillate or
accelerate to a much higher value than the command.

Figure 11. Sensorless Control Tab

DC-DC Status and Control Tab

The DC-DC Status and Control tab allows you to adjust the target voltage of the
DC-DC converter on the Tandem Motion- Power 48 V Board. The converter runs with a
DC Link Voltage of 48 V, if it is powered by a rechargeable battery and you turn on
regeneration. If the motors suddenly stop, the energy regenerated from the motors’
kinetic energy transfers to the battery. However, if a battery is not connected or a
battery is connected but you turn off regeneration and the motors stop suddenly, the
regenerated energy might cause the DC Link voltage to rise suddenly and damage
components on the board. Therefore the default voltage of the DC Link is 32 V to
leave some margin for regeneration.

Figure 12. DC-DC Status and Control Tab

6.2. System Console GUI Lower Pane for the Drive-On-Chip Design
Example

General Tab

Under Data Source:

• In the DSP mode drop-down menu select DSP calculation mode to use
(Software Fixed Point; DSP Builder for Intel FPGAs Fixed point; DSP Builder for
Intel FPGAs Floating Point or Software Floating Point)

• Under the ADC Type drop-down menu, select the ADC to use for feedback
samples (depending on the power board you use)

• Click Show Raw Samples to show raw or scaled samples.

6. Debugging and Monitoring the Drive-On-Chip Design Example with System Console
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Figure 13. General Tab

On the Demo selection: drop-down menu select the control algorithm, type of
commutation, and update rate to use in the demonstration. The available selections
depend on which motor control hardware you use.

The Status: field reports the status of the demonstration. The Runtime: field updates
from the application software.

The Run time measurement dials display the processing time of the FOC control
loop and the overall Interrupt Service Routine (ISR) processing time, including
handling debug trace data. in the currently selected DSP mode.

Waveform Demo Tab

In the Demo drop-down menu select speed, position, or other demonstration.

In the Waveform drop-down menu select the dynamic behavior of the speed or
position demo (constant or varying with sine, square, triangle, sawtooth waveform).

Set the nominal speed or position, waveform period, amplitude and offset and click
Update Demo.

Note: Large step changes in commands (e.g. using square or triangle wave speed demo)
may result in unstable behavior, especially when using sensorless control.
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Figure 14. Waveform Demo Tab

Waveform Tab

The Waveform tab shows the motor control waveform captured as a result of the
trigger settings in the Trace Setup tab..

Figure 15. Waveform Tab

DC-DC Converter Tab

The DC-DC Converter tab shows the DC-DC converter waveforms captured as a
result of the trigger settings in the Trace Setup tab.
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Figure 16. DC-DC Converter Tab

Demonstration Selection

The Demo selection: drop-down on the General tab selects the demo to run:

• Reset

• Open loop sinusoidal 16 kHz Volts/Hz

• Open loop sinusoidal 32 kHz Volts/Hz

• FOC sensor 16 kHz single axis

• FOC sensor 32 kHz dual axis

• FOC sensorless 16 kHz dual axis

• FOC sensorless 32 kHz dual axis

• Trapeziodal Hall sensor 32 kHz dual axis

Battery Monitor

The Battery Monitor tab shows the battery initial parameters, battery monitor
control, and status of battery, including SOC and parameter values.
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Figure 17. Battery Monitor Tab

6.3. Vibration Suppression Tab

6.3.1. About the Demonstration

The demonstration sets the control parameters and runs waveforms to demonstrate
vibration suppression. Alternatively, you may change the settings and run waveforms
manually. Stop the demonstration before making manual changes.

Note: Do not run the demonstration and change the settings simultaneously.

Note: This demonstration is only valid for FOC sensor 16 and 32 kHz dual axis mode.

The demonstration shows how to improve speed control. Speed is never perfectly
constant because motors include discrete parts such as magnets, electrical coils and
steel cages to hold these components. As the motor rotates, the torque produced for a
given current magnitude varies. These variations (cogging torques) produce
accelerations leading to speed variations. The feedback controller adjusts the current
to counteract the speed variations depending on the strength of the control gains.
Stronger gains reduce speed variation, but may lead to control instability or amplify
mechanical resonances.

The demonstration shows the level of speed variation with default speed control gains.
It then shows the speed control step response. The step response should be fast and
with little overshoot or oscillation, so the speed output should look similar to the
square-wave input command. The speed control step response with standard gains is
slow and may stop briefly at zero speed because of friction when the motor changes
direction. Increasing the speed control loop proportional gain makes the response look
much faster and without any visible stop at zero speed. However, the motor produces
high-frequency noise that is audible and visible in the FFTs as a broad peak around
1kHz. In a real system with a mechanism connected to the motor, this noise can easily
excite mechanical vibrations. To counteract this undesirable change, apply the

6. Debugging and Monitoring the Drive-On-Chip Design Example with System Console

683466 | 2022.05.15

Send Feedback AN 669: Drive-On-Chip Design Example for Cyclone V Devices

29

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20AN%20669:%20Drive-On-Chip%20Design%20Example%20for%20Cyclone%20V%20Devices%20(683466%202022.05.15)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


suppression filter using a broad notch characteristic centred on 1kHz. The resulting
waveform still has a fast, square shape, but the filter suppresses the noise. The speed
variation with the combination of high gain and filter is much less than the original
graph, showing the benefit of the faster control.

6.3.2. Starting the Demonstration

1. Click Start demo.

2. Click Advance demo to start the demonstration step 1. The demonstration
highlights the text that describes this step.

3. Click Advance Demo again to start each consecutive step.

4. The demonstration finishes when you click Advance Demo and all text shows
again with no highlighting.

5. To repeat the demonstration, click Advance Demo again.

Figure 18. Vibration Suppression Tab

6.3.3. FFT0 and FFT1 Graphs

On the Vibration Suppression tab, System Console displays the following graphs:

• Input signal to FFT0 against time.

• The magnitude of FFT0 against frequency.

• Input signal to FFT1 against time.

• The magnitude of FFT1 against frequency.

The graphs update at the same time as the graphs on the Control and Diagnostics
tab whenever the trigger function in that tab activates. Within the SoC, the 4,096pt
FFT data recalculates after every 64 new data points. The data sample rate is 16 kHz,
thus the FFTs recalculate at 250 Hz.

System Console saves both the time- and frequency-based data to the .csv file that
you specify in the Control and Diagnostics tab. You can then verify offline the
correctness of the FFT calculation.

The FFT magnitude data is in dB (i.e. 20*log10 absolute value in physical units)
similar to a control system Bode plot.
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A basic peak detection algorithm enables you to measure particular peaks and develop
automated vibration suppression. For each of the two FFTs, the algorithm finds the
maximum magnitude value between two specified frequency limits. Thus, you can
search for peaks within a physically relevant range without seeing large FFT
magnitudes that often occur at low frequencies. System Console shows the peaks with
a cross-hair superimposed on the FFT magnitude graph. It shows the frequency and
magnitude values below the graph.

Figure 19. Using the Graphs

You can zoom into an area of the graph by clicking and dragging the cursor over that
area. To return to the original scaling, right-click on the graph and select Auto Range,
Both Axes.'

6.3.4. Setting Up FFT

1. On the Vibration Suppression tab, select the FFT signal.

2. Select the frequency scale: linear or log.

3. Select the peak detection low and high limit frequencies.

4. Click Update Limits.

6.3.5. Setting Up Command Waveform

You can set up the command waveform to generate repeating waveforms that allow
you to examine the quality of control.

1. Enter values for the parameters.

Table 4. Command Waveform Parameters

Parameter Value Description

Waveform type Sine, Triangle,
Square, Sawtooth

The shape of the repeating waveform.

Period (samples) 2 to 32768 Period of the waveform, in 16 kHz samples. For example, 2000 is equivalent to
8 Hz.

Position amplitude -180 to +180 +/- amplitude of the waveform, if running in position control. Negative values
create a 180 degree phase shift.

Speed amplitude
(rpm)

-2048 to +2048 +/- amplitude of the waveform, if running in speed control. Negative values
create a 180 degree phase shift.

On/Off On or Off Switches the waveform on or off. The waveform is superimposed on the speed
or position set points from the General tab.

2. Click Update waveform.
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6.3.6. Setting Up Second Order IIR Filter

1. Enter values for the IIR filter.

Table 5. IIR Filter Parameters

Parameter Values Description

Fn (Hz) 2 to 8000 The ‘natural frequency’ of the filter numerator, Ωn/2π.

Fd (Hz) 2 to 8000 The ‘natural frequency’ of the filter denominator, Ωd/2π.

Zn (nondimensional) 0 to 1000 The damping factor of the filter numerator, ζn. Values less than 0.707
produce a trough around Fn before the numerator gain increases;
larger values give a smoother (more damped) characteristic.

Zd (nondimensional) 0 to 1000 The damping factor of the filter denominator, ζd. Values less than 0.707
produce a peak around Fd before the denominator gain decreases;
larger values give a smoother (more damped) characteristic.

On/Off On or off. Switches the filter on or off.

Input gain 0 to 1 This gain is in series with the filter and multiplies the complete control
loop. Default to 1, but set to smaller values to reduce the overall
control loop gain if required to improve control loop stability.

2. Click Update Filter.

Related Information

IIR Filter Tuning Parameters on page 75

6.4. Controlling the DC-DC Converter

1. On the DC-DC Status and control tab enter the desired DC link voltage of the
DC-DC converter.

2. Monitor the changes in the waveforms on the DC-DC Converter tab.

6.5. Tuning the PI Controller Gains

The Drive-On-Chip Design Example contains three PI control loops for current (inner
most loop), speed and position. You can tune the gain of each PI control loop.

When tuning these gains, only change the values a little at a time while monitoring
the performance on the Waveform tab.

1. On the Current Control tab, enter values for:

• Kp (proportional gain).

• Ki (integral gain).

2. Click Update Parameters.

3. On the Speed Control tab:

• Enter values for Kp (proportional gain) and Ki (integral gain).

• Click Update Parameters.

4. On the Position Control tab:

• Enter a value for Position Kp.

• Click Update Parameters.
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6.6. Controlling the Speed and Position Demonstrations

The Drive-On-Chip Design Example speed and position demonstrations show constant
or varying speed and position.

1. Selects the way the speed or position varies during the demonstration in the
Waveform drop down.

The speed or position varies according to the selected waveform.

2. Specify the Speed (position) to control the nominal speed or position for the
respective demonstrations.

If you select a non-constant waveform, the speed and position vary around this
nominal value.

3. Specify the Period (ms) to control the period of the speed and position variation
waveform.

4. Specify the Waveform amplitude to control the amplitude of the waveform. For
example, a speed of 100 rpm with an amplitude of 50 rpm gives a speed varying
between 50 and 150 rpm.

5. Specify the waveform offset (ms): to change the waveform phase (shift in time).

6. Specify the Position Speed Limit (rpm) to control the maximum speed in
position demo mode.

If you select Speed in Demo on the Waveform Demo tab, the design ignores
this value.

7. Click Update Demo to apply changes to the design.

6.7. Monitoring Performance

The Drive-On-Chip Design Example offers many way to monitor the performance.

1. On the Trace Setup tab, under Trigger Signal, select the signal you want to
trigger the trace data capture. If you select Always, the trigger is always active.

2. Under Trigger Edge, select a trigger type:

• Level (trigger signal must match this value)

• Rising Edge (trigger signal must transition from below to above this value)

• Falling Edge (trigger signal must transition from above to below this value)

• Either Edge (triggers on both falling and rising edge conditions).

3. Under Trigger Value, select the value that Trigger Edge uses to compare the
signal value against.

4. Click Update Trigger, if you update the Trigger Value.

5. Under Trace Depth, select the number of samples to capture and display.

System Console can store up to 4,096 samples. Select a lower number of samples
to make System Console update rate faster, and zoom in on the graph as the
graph scale autosizes to the number of samples.

6. Specify a Trace Filename.

System Console saves the trace data saved to a .csv file.

7. Click Start Trace to start the trace; click Disable Trace to stop the trace.
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7. About the Scaling of Feedback Signals
Voltage, current, and position feedback signals from the hardware require scaling into
the appropriate physical units before you can use the data in the control loop

The Drive-On-Chip Design Example for Intel Cyclone V devices requires scaling to
convert the feedback samples from sigma-delta into the same units for use in the FOC
algorithm. Also, the design requires scaling to convert current and voltage feedback
values to the units expected by the DC-DC module. The design processes some
feedback as dimensionless data and scales it into a convenient range (e.g. signed 16-
bit integer) for use in the control loop.

7.1. Signal Sensing in Sigma-Delta ADCs

Sigma-delta modulators on the power board convert analog signals to a one-wire
digital bitstream. The design demodulates or filters the bitstream in the FPGA. The
FPGA uses several types of sigma-delta filter IP in the FPGA, ADC modules and DC link
modules, each with different scaling and offset.

The design downloads and filters all sigma delta inputs in parallel so no skew exists
between the samples that it feeds to the software application.

Each ADC type has a different input ranges. The corresponding 'C' data type is 16-bit
integer.

Table 6. ADC Output Data

ADC Type Input Range Count Range C Data type

Sigma-delta ADC -320…+320mV -32768…+32767 Signed 16-bit

Sigma-delta DC link voltage 0…+320mV 0…+32767 Signed or unsigned 16-bit

Position feedback samples are scaled to a 23 bit unsigned integer, for consistency
across all encoder types supported by this and previous Drive-On-Chip designs.

Table 7. ADC Scaling
This table shows the ADC scaling for all signals, ADC type and board revision. The scaling depends on the way
the power board processes the signals (e.g., value of current shunts, scaling, and offset in sense amplifiers).

Feedback Quantity Sigma Delta Interface IP Sigma Delta Scaling for Tandem Motion Power Board

Motor Phase Voltages ADC interface 545 counts/V

DC Bus Voltage ADC interface 40 counts/V

Input Voltage DC Link 895 counts/V

Input Current DC Link 256 counts/A
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Feedback Quantity Sigma Delta Interface IP Sigma Delta Scaling for Tandem Motion Power Board

DC-DC Inductor Current ADC interface 717 counts/A

DC Bus Current DC Link 1638 counts/A

Motor Phase Currents ADC interface 1024 counts/A

Table 8. ADC Scaling
This table shows the ADC scaling for all signals. The scaling depends on the way the power board processes the
signals (e.g., value of current shunts, scaling, and offset in sense amplifiers) and filter IP scaling in FPGA. The
design uses the DC Bus Voltage and DC-DC Inductor Current as feedback control for the DC-DC controller IP,
but scales them differently for the DC-DC controller IP. The design performs the scaling in hardware. The table
shows the scaling factor in the last column in the table. For more information, refer to DC-DC Control Block.

Feedback Quantity Sigma Delta Interface IP Scaling for Software
Interface (Avalon
Memory-mapped

Registers)

Scaling for DC-DC
Controller Hardware

IP

Motor Phase Voltages ADC interface in DOC_Axix_Periphs
subsystem

545 counts/V N/A

Motor Phase Currents ADC interface in DOC_Axix_Periphs
subsystem

1024 counts/A N/A

DC link Input Voltage DC Link Monitor in lvmc_dclink
subsystem

895 counts/V N/A

DC link input Current DC Link Monitor in lvmc_dclink
subsystem

256 counts/A N/A

DC link output (DC Bus)
Current

DC Link Monitor in lvmc_dclink
subsystem

1638 counts/A N/A

DC link output (DC Bus)
Voltage

ADC interface in DC-DC Boost Converter 545 counts/V 40 counts/V

DC-DC Inductor Currents ADC interface in DC-DC Boost Converter 717 counts/A 100 counts/A

7.2. Signal Scaling in the Software of the Drive-On-Chip Design
Example

The software performs scaling to:

• Normalize sigma-delta and ADC samples for use in the FOC algorithm

• Apply zero offsets

• Position feedback scaling
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Figure 20. Signal Scaling Architecture
This figure shows a simplified block diagram of the scaling in the software application supporting the Tandem
Motion-Power 48 V Board.
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Scaling of Motor Phase Current Samples

The design treats motor phase current samples as dimensionless numbers in the FOC
algorithm, rather than real current measurements.

Calculation of Zero Offsets

Offset errors arise in the ADC conversion process from a number of factors, including

• Component tolerance in sense circuits

• Offsets in sense amplifiers

• Errors in Vdd supply to sense amplifiers and ADCs

• Offsets in the ADC converters

Offsets are most noticeable when converting low level signals where they lead to a
larger error in percentage terms. For the most crucial feedback, the design attempts
to calculate and correct for the offsets.

Motor Phase Current Zero Offset

The design calculates the zero offset for the motor phase current during startup. the
design samples a number of conversions while no motor current is flowing. The design
averages the samples to calculate the offset and applies them as a correction to the
offset register in the sigma delta ADC module

7.3. Scale Factors for the Drive-On-Chip Design Example in the
System Console Toolkit

The design applies scale factors to signals in the system console toolkit for diagnostic
display in human readable, physical units (e.g. volts, amps).
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Table 9. Scale Factors in System Console
This table shows the scale factors that the GUI uses, based on the scaling of the motor phase currents as in
Scaling of Motor Phase Current Samples.

Item Sigma Delta Scaling

Motor Phase Voltages 545 counts/A

DC Bus Voltage 545 counts/V

Input Voltage 895 counts/V

Input Current 252 counts/A

Inductor Current 717 counts/A

DC Bus Current 1638 counts/A

Motor Phase Currents 1.024 counts/mA

Table 10. Scale Factors for Id and Iq in System Console
The table shows that scaling of Id (requested and actual) and Iq (requested and actual) in the GUI is the same
as the motor phase current scaling

Item Sigma Delta Scaling (counts/mA)

Id Direct Current 1.024

Iq Quadrature Current 1.024

SVM Voltage

The design calculates the maximum count of the PWM from the PWM clock frequency.
The maximum count varies with the PWM clock frequency and sample rate and is
(PWM frequency in Hz)/( (Sample rate) *1000). For example, with a PWM clock
frequency of 300 MHz and a sample rate of 16 kHz the maximum count is 18,750.

Voltage demand signals for the PWM IP have a full-scale value equal to the maximum
count, so setting the voltage demand to the maximum count value achieves 100%
duty cycle and 100% of DC link voltage. Setting the voltage demand to 0 achieves 0%
duty cycle and 0% of the DC link voltage. By convention, voltages for display purposes
are centred around 0. For example, if the DC link voltage is 48 V voltage demand
signals between 0 and maximum count map to 0 to +48 V outputs, but these signals
are offset and show in System Console as -24 V to +24 V.

Using the above example of 300 MHz PWM and 16 kHz sample rate for the Tandem
Motion-Power 48 V Board, in System Console:

Offset 18,750/2 = 9,375

Scaling 9,375/24 = 391
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8. Motor Control Software
The Drive-on-Chip Design Example motor control software is in C, runs under the
Micrium µC/OS-II real-time Operating System on the Nios II processor, and is in two
parts.

The main program covers the initialization, status reporting, and communication
functions. The ISR covers the real-time aspects of running the motor control FOC
algorithm. The system.h header file is generated from the Qsys system via
the .sopcinfofile, which contains a description of the system interconnectivity and
module base addresses.

Doxygen generated HTML help files are in the software\doxygen directory. Open
the index.html file in a browser to view the help files.

For instructions on how to install doxygen software and generate the HTML help files,
refer to Viewing Motor Control Software Help Files.
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Figure 21. Main Program

Setup drive parameters structure

Initialize Debug RAM

Initialize PI controllers

Initialize DSP Builder PI controllers

Initialize peripherals

Enable IRQ (for selected sample rate)

Poll commands and write
status to debug RAM

Update PI controllers

Measure average IRQ runtime

Print status and error conditions

Respond to reset, 
openloop, speed up, and 
speed down commands
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Figure 22. IRQ Routine

Read position encoder

Convert mechanical position
to electrical position

Calculate position  PI controller 

Calculate speed PI controller

Read feedback current ADC

Apply FOC control algorithm
(software or DSP Builder for Intel

FPGAs hardware options)

Apply space vector 
modulation (SVM)

Write SVM values to PWM block

Write debugging trace values to RAM

Return from IRQ

Related Information

Rebuilding the Drive-On-Chip Design
Instructions to rebuild the BSP after making hardware changes and rebuilding the
application software.

8.1. Viewing Motor Control Software Help Files

Doxygen generated HTML help files are in the software\doxygen directory.

1. Install Doxygen and Graphviz (to generate diagrams).

2. Check that the environment variables are set to point to the correct path:

a. Click Advanced system settings ➤ Environment variables.

8. Motor Control Software
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b. Click on Path in the System Variables pane and select Edit

c. Select Browse… and add <path>\doxygen\bin and <path>
\Graphviz2.44\bin directories.

3. Open a Nios II command shell and change directory to software/doxygen in
your project directory.

4. Write the command “make doxygen” to generate HTML help files in the same
directory.

5. Open the index.html file in a browser to view the help files.

Related Information

• Doxygen

• Graphviz

8.2. Software Application Configuration Files

You can modify the operation of the software application for the Drive-On-Chip Design
Example by editing some C source code and header files.

Table 11. Software Application Configuration Files

File Path Function

demo_cfg.c . Declare motors[] Array

demo_cfg.h . Configuration macros and include file for demo_cfg.c

motor_types.c Platform/motors Declares motor types and encoders

motor_types.h Platform/motors Defines motor and encoder types and include file for motor_types.c

Table 12. Configuration Macros
This table lists the configuration macros that you can use to configure the design in demo_cfg.h.

Macro Default State Range Function

FIRST_MULTI_AXIS 0 0 - 1 Index of first motor axis to
be controlled.

LAST_MULTI_AXIS 1 0 - 1 Index of last motor axis to
be controlled.

DEFAULT_ADC_TYPE ADC_TYPE_SIGMA_DELTA ADC_TYPE_SIGMA_DELTA Use sigma delta ADC
samples in control loop.

SD_ADC_FILTER ADC_D_10US ADC_D_10US Sinc3filter delay 10us.

ADC_D_20US Sinc3filter delay 20us.

DC_LINK_STARTUP_TARGET_VOLTS 32 12 - 48 Target voltage for DC-DC
converter.

OPEN_LOOP_INIT 0 0 Start motors in closed loop
mode.

1 Start motors in open loop
mode.

INTERACTIVE_START 0 0 Normal startup 1:

continued...   
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Macro Default State Range Function

1 User prompted via terminal
emulator console at each
stage of startup

ENCODER_SERVICE Undefined Undefined Normal operation.

DBG_DEFAULT DBG_INFO DBG_NEVER No console output.

DBG_ALWAYS Always output.

DBG_FATAL Debug level set to fatal
errors .

DBG_ERROR Debug level set to nonfatal
errors and above .

DBG_WARN Debug level set to warnings
and above .

DBG_INFO Debug level set to
information and above .

DBG_PERF Debug level set to
performance data and
above .

DBG_DEBUG Debug level set to debug
messages and above .

DBG_DEBUG_MORE Debug level set to more
debug messages and
above .

DBG_ALL Debug level set to all
messages.

8.3. Defining a New Motor or Encoder Type

1. To use a different motor type or position feedback encoder with the Drive-On-Chip
Designs, declare a new motor type array of type motor_t in motor_types.c.

2. Provide C source code for the three functions encoder_init_fn,
encoder_service_fn and encoder_read_position_fn if none of the
existing functions are suitable.

3. Use the functions provided with the design as templates to write your own
functions.

4. Initially, use the gain constants from an existing motor type and then determine
new values when you first run the motor by following a standard PI controller
tuning process.

Refer to the declaration of tamagawa_resolver software source file as an
example.

5. Edit the declaration of the motors[] array in demo_cfg.c to use your motor.

The default motors[] definition for the Tandem Motion-Power 48 V Board is two
Tamagawa motors with resolvers:

motor_t * motors[] = {&tamagawa_resolver[1],
&tamagawa_resolver[1], NULL, NULL};
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The resolver interface on the Tandem Motion-Power 48 V board converts the
resolver output into quadrature equivalent or Hall equivalent encoder signals. The
design supports a maximum of two axes so the third and fourth elements of the
motors[] array are set to NULL for clarity.

8.4. SoC HPS Motor Control Software Project

The SoC HPS motor control software project is a makefile project for the Intel SoC
Embedded Design Suite. The single project contains both the application source and
the μC/OS-II source. You can load this standalone application from Arm Development
Suite or using U-boot from an SD card.

Intel provides an Arm Development Studio debug script that first loads and runs the
preloader, then loads and runs the application to a breakpoint at main(). Execution
can continue from this point or you can set further breakpoints or configure memory
watch windows.

8.5. Building the HPS Preloader

Intel provides prebuilt preloader image in the software\spl_bsp\uboot-socfpga
\spl directory. Only build the preloader if you change the HPS hardware settings.

1. Delete the existing \software\spl-bsp directory to remove the old preloader.

2. Start SoC EDS command shell.

3. Start the Preloader Generator (BSP Editor) by typing the following command in
SoC EDS command shell:

bsp-editor &

4. In the BSP Editor, select File ➤ New HPS BSP ...

5. In the New BSP window under Preloader settings directory, click ... to browse
to the handoff folder.

6. Select the <project_dir>/hps_isw_handoff/
DOC_TANDEM_CVSX_QSYS_hps_0 directory and click Open.

The New BSP window has all the settings populated, based on the handoff folder.

7. Accept the default settings and click OK. The window closes.
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Figure 23. BSP Editor

8. In the BSP Editor window, expand Advanced ➤ boot and turn off
WATCHDOG_ENABLE, as the watchdog timer must be off, then click Generate.

Figure 24. BSP Editor Settings

The message panel on the bottom indicates the status of the generation.

9. Click Exit to close the BSP Editor.

10. In the SoC EDS command shell, type the following command:

cd <project_dir>/software/spl_bsp

11. Type the command: make.

If you see the following error message, refer to the Unable to make preloader in
Windows 10 webpage on the RocketBoards website.
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Figure 25. Error Message

Related Information

• Preloader User Guide in the SoC EDS User Guide

• RocketBoards
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9. Functional Description of the Drive-On-Chip Design
Example

The design consists of two main elements: Qsys, DSP Builder for Intel FPGAs, IP, and
RTL sources compiled into an FPGA programming file; and C source code compiled to
run on an Arm Cortex-A9 in the HPS in the FPGA.

Figure 26. Block Diagram for Cyclone V SoC Development Board
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The Qsys system consists of:

• Processor subsystem

• DC link monitors

• DC-DC converter
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• FOC subsystem

• FFTs

• Two motor drive axes comprising the following motor control peripheral
components:

— 6-channel PWM

— Drive system monitor

— Quadrature encoder interface

— Resolver SPI interface

— ADC interface

Figure 27. Qsys System Top-Level Design

Figure 28. Qsys System for a Drive Axis
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Figure 29. Qsys System for DC-DC Converter

9.1. Processor Subsystem

The Drive-On-Chip Design Example processor subsystem offers a fully functional
processor system with debugging capabilities:

The processor subsystem comprises the following Qsys components:

• Arm Cortex-A9 in the HPS

• Floating-point hardware custom instructions (optional)

• JTAG master

• Performance counters

• MOSFET gate driver SPI

• JTAG UART

9.2. Six-channel PWM Interface

The Drive-On-Chip Design Example six-channel PWM interface operates as three pairs
of outputs, with each driving the upper and lower power transistors (e.g., MOSFET
driven via external drivers) in a half-bridge power stage.

The PWM interface operates with a PWM carrier clock of 300 MHz for high resolution
control of the MOSFET switching times.

The PWM interface ensures a dead time between switching to ensure both outputs are
not high at the same time; the dead time prevents short circuit “shoot-through” in the
power transistors. The input clock and a PWM counter set the PWM frequency. The
counter alternately ramps up from zero to a maximum value and ramps down from
the maximum value to zero. The sequence is as follows:

0, 1, 2, …, max - 1, max, max - 1, …, 2, 1, 0, …
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Figure 30. PWM Counter Value

1 0 1 ... max - 1 max max - 1 ... 1 0 1 2

The maximum value of the counter ramp, max, is software configurable. The PWM
frequency is fPWM = fCLK/(2 x max)

The design generates high- and low-side drive signals for the MOSFET module by
comparing the ramp counter value with the values you set in the PWM threshold
configuration registers. The design inserts a dead period between the switching of the
upper and lower drive signals according to the value set in the PWM blocking time
configuration register.

The design sets carrier_latch output signal high for one clock cycle when the PWM
counter is at 0 or max. This signal triggers a position encoder to take a position
reading.

Based on the PWM counter value, the PWM component generates configurable timing
output strobes for triggering ADC conversion for feedback-current readings. Configure
the ADC start pulse to perform the conversion during the quietest period of the PWM
cycle away from PWM switching events (around the min and max values of the PWM
counter).

The start output signal is a trigger for the ADC IP to start conversion. The trigger_up
configuration register sets the PWM count value and the start signal is high for one
clock cycle while the PWM is counting up. The trigger_down configuration register sets
the PWM count value and the start signal is high for one clock cycle while the PWM is
counting down. Set the trigger_up and trigger_down registers symmetrically to ensure
a regular ADC sample position offset before the reversal point of the counter. In other
words, trigger_up = MAX - offset, and trigger_down = offset.

The design calculates the PWM blocking time configuration register as pwm_block =
dead time x fCLK. Dead time refers to the time when the design turns off both upper
and lower transistors, to prevent short circuits. You must obtain specific dead time
values for the specific MOSFET module you are using. For example, with a dead time
requirement of 2μs and a PWM module clock of 300 MHz, the pwm_block value is 600
(=2μs x 300 MHz. Figure 5 shows PWM output generation (including dead time).
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Figure 31. PWM Output Generation (Including Dead Time)

... 100 101 102 ... ...151149 150

100

50

PWM Threshold

Block Time

PWM Count

PWM High

PWM Low
Dead Time

Figure 32. Configurable Timing Output Strobes
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9.3. DC Link Monitor

The Drive-On-Chip Design Example DC-link monitor uses an instance of the sinc3 filter
module, similar to the instance that the sigma-delta interface for drive axes uses.
Three DC link monitor modules monitor DC link input voltage, DC link input current,
and DC link output current. All three modules reside in lvmc_dclink.qsys
subsystem.

The design compares the software configurable reference values with the filtered DC-
link voltage and current values to determine if the DC-link voltage and current are
within the expected range. Status outputs indicate overvoltage, undervoltage, and
overcurrent conditions.

The design feeds these status output signals to the DC-DC converter module and
shuts down the DC link output when any abnormal state occurs.
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ADC Interface Result

The DC link voltage restricts the demodulated result of the DC-link monitor to a
positive value because the DC-link voltage cannot be negative. The design clips any
negative result after applying the offset correction to zero. The DC link input current
and output current clips the demodulated results to fit within 16 bits signed integer
range.

Offset Adjustment for DC-Link Monitor

The design adds offset values to demodulator results. The design specifies offset
values in the Offset register. During normal operation, the offset value is 16,384.

9.4. Drive System Monitor

The Drive-On-Chip Design Example drive system monitor is a state machine that
responds to state requests from the software and fault signals from hardware.

Application software writes to the drive system monitor to request a change of state.
The hardware may accept or decline the change of state request, depending on the
system status (for example, overvoltage status, undervoltage status, and current
measurements alter the system status). A subsequent read from the Status register
verifies if the design accepts the change of state.

The drive system monitor latches status signals from the system so the signals are
available as status register bits and direct outputs. For example, the direct outputs
can drive status LEDs.

9.4.1. Drive System Monitor States for the Drive-On-Chip Design Example

Table 13. Drive System Monitor States

State Name System State

0 Idle Reset state, moves immediately to preinit

1 Precharge PWM counter running, low side outputs enabled, voltage errors monitored

2 Prerun PWM counter running, low side outputs enabled, voltage and current errors
monitored

3 Run PWM counter running, low and high side outputs enabled, voltage and current
errors monitored

4 Error Error state, PWM counter running, outputs disabled

5 init PWM counter running, outputs disabled, voltage errors monitored

6 preinit PWM counter running, outputs disabled

9.5. Quadrature Encoder Interface

The Drive-On-Chip Design Example quadrature encoder interface monitors and
decodes the A, B and I signals from a quadrature encoder. The resulting output is a
count value representing the position of the motor shaft.
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The quadrature encoder interface allows you to:

• Program maximum count value to match a wide range of encoders.

• Increment or decrement the counter on each A or B input edge.

• Capture the latest count value on an index pulse.

• Reset the count value on an index pulse.

• Reverse the direction of the count, equivalent to swapping the A and B inputs.

• Capture the latest count by an external strobe to synchronize with the PWM
module and ADC sampling.

9.6. Sigma-Delta ADC Interface for Drive Axes

The Drive-On-Chip Design Example sigma-delta ADC interface samples the 20-MHz 1-
bit ADC serial input for 3 phase current inputs for each drive axis. A decimating sinc3

filter in the FPGA then low-pass filters the serial input. The sinc3 filter does not require
hardware multipliers.

Sinc3 Filter

Figure 33. Sinc3 Filter Topology
The input samples pass through three integrator stages before a factor M decimates them. The design reserves
every Mth sample and discards M-1 samples. The design passes the reserved samples through three
differentiators to produce a final output value.
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The pulse-width modulation (PWM) block triggers ADC conversion with a reset signal
that resets the filters and control logic. The design calculates:

• The direct-current gain of the sinc3 filter as GainDC = MK (where K = 3 for sinc3).

• The internal bus width of the filters as Internal bus width = 1 + Klog2M, to
account for word growth in the filter stages

• The output data rate for an input sample rate fS and decimation factor M as Data
rate = fS/M.

When the settling time satisfies and the ADC conversion completes, the design sends
an interrupt to the processor.

The sinc3 filter requires a time period 3× longer than the time period of the output
data rate to settle. The standard settings of M=128 keeps the settling time short and
a deliver a suitable ENOB of 16bits. By choosing to synchronize sampling to the quiet
periods of the PWM waveform, signal quality is acceptable when sampled at 16 kHz
despite the theoretical output data rate of 156.2 kHz.
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Table 14. Sinc3 Filter: Fs = 20 MHz

Decimation (M) GainDC Word Size Bus Width Data rate (kHz) Settling Time (µs) ENOB

8 512 9 10 2500 1.2 6.4

16 4096 12 13 1250 2.4 8.9

64 262,144 18 19 312.5 9.6 13.9

128 2,097,152 21 22 156.2 19.2 16.4

Two Filter Paths

The design has two separate filter paths: a control loop filter path and an overcurrent
detection filter path.

The control loop filters are slower but more accurate than the overcurrent detection
filters with a software selectable decimation factor of M=128 or M=64. The control
loop filters have an offset correction feature for zero-offset correction. The filter output
is a signed 16 bit (2's complement) format.

The overcurrent detection filters are faster but less accurate than the control loop
filters with a software selectable decimation factor of M=16 or M=8. A software
configurable overcurrent output provides a direct output to disable the motor when
under hardware control.

The control loop and overcurrent detection filters use the same control bit for
decimation selection. The possible selections are:

• control loop M=128, overcurrent M=16

• control loop M=64, overcurrent M=8.

Clocks

The design performs synchronization between the ADC clock and the FPGA system
clock at the output stage before the design delivers output data in the Avalon
memory-mapped interface agent registers.

The external ADC components require a clock source from the FPGA and return
samples synchronous to the FPGA-sourced clock. The same clock within the FPGA
drives the ADC filters.

You must apply appropriate timing constraints in the Intel Quartus Prime software
project to guarantee correct sampling of the ADC interface data. Base the sampling on
the clock to output specification of the ADC.

9.6.1. Offset Adjustment for Sigma-Delta ADC Interface

Use the offset adjustment to calculate the output voltages in the Drive-On-Chip
Design Example.
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Table 15. Sigma-Delta ADC Characteristics
The table describes typical characteristics of a sigma-delta ADC and the demodulated output of the sinc3 filter.
The output code is a positive value.

Analog Input Voltage Input (mV) Density of 1s Demodulated ADC Code (16-bit)

Full-scale range 640 - -

+ Full scale + 320 100% 65,535

+ Recommended input range + 200 31.25% 53,248

Zero 0 50% 32,768

- Recommended input range - 200 18.75% 12,288

- Full scale - 320 0% 0

The design adds offset values to demodulator results to represent the bipolar input
signal and to allow for zero-offset adjustment. The offset values are in the offset_u or
offset_w registers.

During normal operation, the offset value is 32,768, or 50% of the full-scale range, to
bring the demodulated result into the range of -32,768 to +32,767. The design
adjusts the offset value to correct for zero-offset errors during calibration.

9.7. DC-DC Converter

The Drive-On-Chip Design Example DC-DC converter comprises two-phase DC-DC
converter power electronics on the Tandem Motion-Power 48 V board and IP.

Figure 34. DC-DC Converter Block Diagram
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The power electronics hardware includes:

• Two inductors (phases)

• Two MOSFET half-bridges

• MOSFET gate driver chip per MOSFET half-bridge

• Current sensing of each inductor current: the total DC link input current and the
total DC link output current

• Voltage sensing of the DC Link input voltage and DC Link output voltage
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The low voltage two-phase DC-DC boost converter includes:

• Three sigma-delta ADC interfaces

• DC-DC control block

• Avalon memory-mapped agent interface for control and status

• Fault flag logic

Intel developed the converter using DSP Builder for Intel FPGAs.

The DC-DC converter consists of 2 phases that provide bidirectional power flow from a
low voltage power source or battery (typically 12 V DC) to a DC link output bus
(maximum 48 V DC) that feeds one or more motor drive inverters. The DC-DC
converter provides the boost function to increase the voltage. It also provides a buck
function during periods of regenerative braking to deliver power from the DC link
output bus back to the low voltage source (i.e., battery in this case).

The gate driving signals for the two phases are 180 degrees out of phase so that they
alternate in supplying current during buck-boost function, which gives smoother
output current and voltage.

The control consists of two independent inner current loops and an outer voltage loop
that regulates the DC link output bus voltage to a specified value (e.g., 32 V DC). An
external host (e.g. the Arm processor) gives the target value via the Avalon memory
mapped agent interface.

For feedback control, the DC-DC control block takes the output of the two inductor
current and DC link output voltage ADCs outputs. The design connects the outputs of
the DC link input voltage, the DC link input current, and the DC link output current
ADCs with DC link monitors to detect fault conditions for external host monitoring.

Low-Voltage Two-phase DC-DC Boost Converter

The top-level module of the DC-DC converter is a Qsys component, which is a
manually-created HDL module that:

• Instantiates the VHDL entity generated by DSP Builder for Intel FPGAs (the DC-DC
control block)

• Instantiates sigma-delta ADC interface module

• Adds an Avalon memory-mapped register agent and conduit signals.

The design instantiates the DC-DC Converter in the lvmc_dclink.qsys subsystem.

You can instantiate the Qsys component in a Qsys system and connect it to the Arm
processor and other modules. The register agent allows software access to the DC-DC
converter parameters, control, and status. The conduits connect to various system-
wide control and status signals that are outside the software domain.

The top-level module implements safety features in the fault flag logic that you may
use with external logic, to protect the system in the case of a malfunction. The fault
flag logic combines (logical ORs) three fault bit signals provided by the DC link
monitors. They monitor the total DC link input current, the DC link input voltage, and
the total DC link output current, and gate the following two independent enable
sources that enable the DC-DC converter:

• The enable bit in the control register

• The enable input for the DSP Builder block.
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The ADC interface in the DC-DC converter has three demodulators for one-bit sigma-
delta signals, which sense the following DC link feedback signals:

• The output voltage

• The two output inductor currents

The ADC interface delivers 16-bit ADC values at 156 kHz, which is 1/128 of 20 MHz.
The design feeds the ADC output values to the DC-DC control block to carry out the
feedback control loops. The voltage feedback control and two inductor current
feedback control loops run autonomously in hardware, without software interaction in
the loop execution.

Related Information

Avalon Interface Specification

9.7.1. DC-DC Control Simulink Models

The Drive-On-Chip Design Example includes three MATLAB Simulink models, which
lead step by step from offline simulation to HDL code generation while maintaining the
numerical simulation results.

The models are:

• lvdcdc_simpower.slx where the power electronics simulate in SimScape and
the PI control loops in Simulink standard blocks

• lvdcdc_2phase_hwsim.slx is similar to lvdcdc_simpower.slx but the
power electronics simulate in standard Simulink blocks, not SimScape

• lvdcdc_adsp_vhdl.slx is like lvdcdc_2phase_hwsim.slx but the algorithm
is implemented using DSP Builder for Intel FPGAs so that you can generate HDL
code.

Figure 35. DC-DC Converter Linear MATLAB Model
The figure shows the linear MATLAB model (lvdcdc_simpower.slx). The linear model cannot generate
VHDL, but you create it to provide a rapid simulation to develop control dynamics and determine controller
gains.
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Figure 36. DC-DC Converter: DC bus Voltage, Inductor Currents, Motor Load Current
(stimulus)
The figure shows the linear MATLAB model (lvdcdc_simpower.slx) and simulation.

Figure 37. DSP Builder for Intel FPGAs Top-level Model
The DSP Builder for Intel FPGAs model (lvdcdc_adsp_vhdl.slx) performs the same simulation as above, but
includes DSP Builder for Intel FPGAs blocks that allow simulation of VHDL and auto-generation of VHDL code.

9.7.1.1. DC-DC Control Block

The Drive-On-Chip Design Example DC-DC Converter block contains a DC-DC Control
block, which is implemented in a DSP Builder for Intel FPGAs model
(lvdcdc_adsp_vhdl.slx)
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The DC-DC control block consists of

• Fault latches block

• PI controller block

— Two independent current control loops

— Voltage control loop

• PWM block

Figure 38. DSP Builder for Intel FPGAs DC-DC Control Block
The figure shows the expanded DC-DC Control block

The DC-DC control block has the portion of the simulation for which you generate
VHDL code. The ChannelIn and ChannelOut blocks are the port interface for the
VHDL code. The MATLAB Simulink* inport and output signals define the VHDL signal
names, and the VHDL data formats are the signal formats that you typically set with
the Convert block.

The Convert DSP block sets the data format. This model uses signed-fractional data
format for the feedback signals and the control math inside the DC-DC Control block.

For instance, the voltage feedback signal voltage_fdbk comes into the DC-DC
Control block with data format sfix13 and scaling “2^0” (“13bits . 0bits”, where
13bits includes sign bit), which matches the 12 bit ADC twos-complement format. DSP
Builder for Intel FPGAs also uses twos-complement maths to perform any calculations.

After the signal voltage_fdbk is inside the DC-DC control block the resolution is
increased with another convert block to “sfix(27)” with output scaling “2^-12”
(“15bits . 12bits").

In the PWM block, the design generates a triangular wave bounded within [-1.1] using
a SR latch and counter counting at the frequency of the system clock of 20 MHz. After
every 10000/freq_khz steps, the counter changes the direction of up-down counting.
The design compares the triangular signal with thresholds representing the PWM duty
cycle commands bounded within [-0.9, 0.9] to produce pulses for driving gates for
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each phase. The design inserts dead-time of ten samples time duration (for clk=20
MHz) at every transition of gate driving signals. You can extend the dead time by
increasing the number of sample delays.

If the design asserts the fault input to the DC-DC converter, the enable bit in the DC-
DC converter’s control register is cleared and the DC-DC converter turns off. The
enable bit remains cleared, and writing to the control register cannot set it again until
the system negates the fault input.

The port map for the DSP Builder for Intel FPGAs-generated VHDL entity is:

entity lvdcdc_adsp_vhdl_DC_DC_Control is
    port (
        in1 : in std_logic_vector(0 downto 0);  -- ufix1
        in2 : in std_logic_vector(7 downto 0);  -- ufix8
        CMD_DC_in : in std_logic_vector(13 downto 0);  -- ufix14
        voltage_fdbk : in std_logic_vector(12 downto 0);  -- sfix13
        current_fdbk_a : in std_logic_vector(12 downto 0);  -- sfix13
        current_fdbk_b : in std_logic_vector(12 downto 0);  -- sfix13
        freq_khz : in std_logic_vector(13 downto 0);  -- ufix14
        enable : in std_logic_vector(0 downto 0);  -- ufix1
        open_0_close_1 : in std_logic_vector(0 downto 0);  -- ufix1
        duty_0_100 : in std_logic_vector(13 downto 0);  -- ufix14
        pwm_sync_n : in std_logic_vector(0 downto 0);  -- ufix1
        pgain_voltage : in std_logic_vector(13 downto 0);  -- ufix14
        igain_voltage : in std_logic_vector(13 downto 0);  -- ufix14
        pgain_current : in std_logic_vector(13 downto 0);  -- ufix14
        igain_current : in std_logic_vector(13 downto 0);  -- ufix14
        bidir_en : in std_logic_vector(0 downto 0);  -- ufix1
        out1 : out std_logic_vector(0 downto 0);  -- ufix1
        out2 : out std_logic_vector(7 downto 0);  -- ufix8
        gate_a_l : out std_logic_vector(0 downto 0);  -- ufix1
        gate_a_h : out std_logic_vector(0 downto 0);  -- ufix1
        gate_b_l : out std_logic_vector(0 downto 0);  -- ufix1
        gate_b_h : out std_logic_vector(0 downto 0);  -- ufix1
        OV : out std_logic_vector(0 downto 0);  -- ufix1
        OC : out std_logic_vector(0 downto 0);  -- ufix1
        clk : in std_logic;
        areset : in std_logic
    );
end lvdcdc_adsp_vhdl_DC_DC_Control;

9.7.1.1.1.  DC-DC Model and VHDL Entity Signal Names and Data Format

Signals for the Drive-on-Chip Design Example.

Table 16. DC-DC Model and VHDL Entity Signal Names and Data Format

Signal Name Data Format Scaling Default/Notes

Inputs

In1 ufix1 0

In2 ufix8 0

CMD_DC_In ufix14 1 V = 1 48

voltage_fdbk sfix13 0.025 V = 1 or 1 V = 40

current_fdbk_a sfix13 0.01 A = 1 or 1 A = 100

current_fdbk_b sfix13 0.01 A = 1 or 1 A = 100

freq_khz ufix14 62

enable ufix1 1
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Signal Name Data Format Scaling Default/Notes

open_0_close_1 ufix1 1

duty_0_100 ufix14

pwm_sync_n ufix1 1 (low to reset PWM counter)

pgain_voltage ufix14 1/100 300 (* 1/100 = 3)

igain_voltage ufix14 1e-7 (1/fclk) 4000

pgain_current ufix14 1/1000 20 (* 1/1000 = 0/02)

igain_current ufix14 1e-7 (1/fclk) 25

clk std_logic 20 MHz

bidir_en ufix1 0 for PS, 1 for battery

areset std_logic 0

Outputs

out1 ufix1

out2 ufix8

gate_a_h ufix1 MOSFET gate signal

gate_a_l ufix1 MOSFET gate signal

gate_b_h ufix1 MOSFET gate signal

gate_b_l ufix1 MOSFET gate signal

ov ufix1 High = overvoltage

oc ufix1 High = overcurrent

9.7.1.2. Generating VHDL for the DSP Builder for Intel FPGAs Models for the DC-
DC Converter

1. Start DSP Builder for Intel FPGAs.

2. Change the directory to the ip\dspba\two_phase_dc_dc.

3. If you want a different numeric precision, edit the setup_<Simulink Model>.m
file corresponding to the model before opening it.

4. Load the model.

5. Check the status of the orange DSP Builder for Intel FPGAs folding block. If the
model includes it, folding is enabled. If it is removed or commented out, the model
does not use folding.

6. Click Simulation ➤ Start .

DSP Builder for Intel FPGAs generates the VHDL files in ip\dspba
\two_phase_dc_dc\rtl.

9.7.2. Sigma-Delta ADC Interface for DC-DC Converter

This interface is like the sigma-delta ADC interface for the motor drive axes.
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The interface samples the 20-MHz 1-bit ADC signal inputs and applies a low pass sinc3
filter. Unlike the ADC interface for drive axes, the ADC Interface for the DC-DC
Converter demodulation is always running and it generates filtered 16-bit results at
156.25 kHz, which is 1/128 of 20 MHz.

9.8. Motor Control Modes

The Drive-On-Chip Design Example supports various control algorithms and
commutation modes.

The design supports:

• Open-loop Volts/Hz speed control with sinusoidal commutation

• Speed and position control with field-oriented current control (FOC), sinusoidal
commutation with quadrature encoder or resolver feedback

• Sensorless speed control with field-oriented current control using a sliding-mode
speed and position observer using current feedback

• Speed control with trapezoidal commutation using Hall sensor feedback

Open Loop

The design supports open loop control using sinusoidal commutation and trapezoidal
commutation. The design uses Volts per Hz control in which the voltage the design
applies to the motor increases with increasing frequency (motor speed). After each
interrupt the interrupt service routine (ISR) updates a ramp generator to represent
the motor electrical angle based on the previous angle, desired speed, and sample
rate. The ISR calculates the voltage to apply using a Volts per Hz control gain based
on the frequency and motor parameters. In open loop sinusoidal commutation, the
ISR applies the inverse Park Transform and SVM function from FOC to generate
sinusoidal commutation.

Figure 39. Open Loop Sinusoidal Commutation
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FOC with Position Sensor Feedback

The design supports FOC sensor control where the motor position feeds back to form a
closed loop with position and speed PI control. The design senses the motor position
by incremental (quadrature) encoders.

The design samples and uses the motor phase currents as feedback to the FOC
algorithm.
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Figure 40. FOC with Position Sensor Feedback
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FOC Sensorless

The design supports FOC sensorless control in which the design samples and uses
both the motor phase voltages and currents as the feedback to the control loop.

The phase voltage calc block derives signals Vα and Vβ, scaled and normalized with
respect to the DC bus voltage (Vdclink). The DC bus voltage may drop during quick
acceleration or rise during regeneration. If you do not expect the bus voltage to
change much (e.g. large bus capacitance), you may use Vα and Vβ generated from the
inverse Clarke transform. The software function Phase_Volt_Calc_f() implements
the phase voltage calculations using floating-point arithmetic.

The design integrates the speed estimator with the sliding mode observer (SMO) to
allow a second order observer to calculate both estimated angle and estimated speed
together. In FOC sensorless mode, the motor starts initially in open loop with a
requested speed and switches to sensorless mode after a preset time to allow the
SMO to settle. The software function SMO_Calc_f() implements the SMO calculations
using floating-point arithmetic.
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Figure 41. FOC Sensorless Control
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Sliding Mode Observer Theory

Figure 42. SMO_Calc_f() software function
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The observer, based on the electrical model, estimates the rotating back-EMF vector.
The rotor position determines the direction of the back-EMF, which enables estimation
of position. At constant speed, back-EMF components are sinusoidal in quadrature, as
are error signals. Considering voltage V and current I in one motor phase with
resistance Rs, inductance Ls. Net applied voltage V is at the motor terminal, and the
centre of the motor is at 0 V.

v = iRs + di
dt Ls

Solvinge the differential equation for i, assuming a constant v applied over sample
time T, initial current i, and current at the end of T i+1, gives:

ik + 1 = ike−
Rs
Ls

T + vk
1
Rs

1 − e−
Rs
Ls

T
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Normalizing by some Vmax and Imax to create variables that are non-dimensional and
always <1, gives:

i
Imax k + 1 = i

Imax ke−
Rs
Ls

T + v
Vmax

Vmax
ImaxRs

1 − e−
Rs
Ls

T

i
Imax k + 1 = i

Imax
Aparm + v

Vmax
Bparm

Aparm = e−
Rs
Ls

T

Bparm = 1 − Aparm
Vmax

ImaxRs

Aparm is non-dimensional, represents the electrical system dynamics. Ls/Rs is the
electrical time constant, Ts is the discrete sample time. Aparm should be close to 1 if
the sample time is much faster than the motor time constant.

Bparm uses Vmax/(Imax*Rs) so is also nondimensional. (1-Aparm) is small.

Aparm and Bparm are constant and are calculated once during initialization of the
software.

Angle Tracking Observer Theory

The angle tracking observer (part of SMO_Calc_f()) takes the estimated back-EMF
vector as input and outputs an estimated rotor position (phi_SMO). The back-EMF
estimate may be noisy so the observer filters it and converts it to position. The design
provides two methods:

1. #if (TRACKER_ENABLE == 0), arctan method: A first order filter with gain
Lpf_Gain is applied to both alpha and beta components of the back-EMF before
using arctan to convert them to phi_SMO. The advantage is simplicity, but velocity
must be estimated separately. The design does not use this method as the speed
estimation may introduce lag.

2. Angle observer method: The design combines the back-EMF estimates with the
last phi_SMO to calculate AObsError, which is proportional to speed*sin(actual-
estimate). Assuming small errors and constant speed, AobsError=K*(θElec -
phi_SMO). Phi_SMO has units of fraction of 1rev (0..1 for 0..2π rad).

Figure 43. Angle Tracking Observer
Induced voltage ve = d/dt(φ) = Rotor back-EMF in q-direction in FOC. Rotor electrical angle θelec = direction of
magnetic flux vector φ = d-direction in FOC.
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The back-EMF operates in the q-direction,, which is at right-angles to the d-direction
(θelec_rad). The components of the back-EMF in the fixed alpha and beta directions
are:

• vBemfAlpha_V = -dθmech_dt_rad_s*Ke_Vs_rad*sin(θelec_rad)

• vBemfBeta_V = dθmech_dt_rad_s*Ke_Vs_rad*cos(θelec_rad)

• AobsError is the back-EMF in the estimated d direction (phi_SMO), which is zero if
phi_SMO is equal to θelec_rad

• AObsError = -vBemfAlpha_V*cos(phi_SMO)-vBemfBeta_V*sin(phi_SMO)

Substituting the Bemf equations into the AObsError equation:

AObsError = dθmech_dt_rad_s*Ke_Vs_rad*( sin(θelec_rad)*cos(phi_SMO)-
cos(θelec_rad)*sin(phi_SMO) )

= dθmech_dt_rad_s*Ke_Vs_rad*sin(θelec_rad - phi_SMO)

Hence, if the BemfAlpha and BemfBeta values are correct, AObsError measures the
angle estimation error (θelec_rad - phi_SMO).

For small error angles and at constant speed, assume AObsError = K*(θelec -
phi_SMO)

AObsError = K(θk- φk)

The software creates a second-order filter from θelec to phi_SMO. Filter natural
frequency Ω and damping coefficient ζ are design parameters tuned for the Tamagawa
motors in the Tandem Motion-Power 48 V motor kit. The normalized scaling makes
them suitable for other motors too with possible retuning. Carefully tune this non-
linear observer because incorrect position estimates can make the FoC algorithm
oscillate or become unstable by causing positive feedback.

Figure 44. Feedback System
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SMO Parameters

The design derives various SMO parameters from the motor parameters for each
motor type, such as resistance and inductance. Other SMO parameters, and default
values, are:

Table 17. SMO Parameters

Parameter Description

Lpf_Gain = 0.10 Arctan method of angle calculation only. The final two stages of the SMO are a low-pass filter
on each component of the estimated BEMF followed by an inverse tangent (arctan observer).
The output of the inverse tangent is the estimated angle. The parameter Lpf_Gain sets the
cutoff frequency of the low-pass filter.
Lpf_Gain = 2*pi*fc*Ts
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Parameter Description

where: Ts is the sample period and fc is the desired cutoff frequency.

damping_coefficient =
1.4

These are both parameters of the angle tracking observer, which takes in both unfiltered
components of the estimated BEMF, extracts the angle and filters in one module. The angle
tracking observer has no speed dependent phase lag, unlike the arctan observer. Setting
natural_frequency too low can result in instability in the speed estimation.natural_frequency = 600

Hys_Gain = 0.8 This parameter sets the sliding mode gain on the current observer. This observer is responsible
for estimating the BEMF signals that it ultimately feeds into the angle tracking observer. To
adjust this parameter, run the motor and view the estimated angle waveform. If it looks like an
undistorted triangle no adjustment should be necessary. If the triangle looks distorted, while
running at constant speed, adjust this parameter to clean it up.

Trapezoidal

The design supports trapezoidal control of BLDC motors using Hall sensor feedback on
the Tandem Motion-Power 48 V Board. The software supports Duty Mode and Torque
Mode, but the demonstration GUI only uses Velocity Mode. The software
reconstructs the motor current from the individual phase current readings using the
Hall encoder state to determine which phase current is relevant.

Figure 45. Trapezoidal Commutation Using Hall Sensor Feedback
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9.9. FOC Subsystem

The Drive-On-Chip Design uses DSP Builder for Intel FPGAs to generate the HDL code
for floating-point and fixed-point implementations of the field-oriented control (FOC)
algorithm. The processor uses this DSP Builder-generated FOC IP as a coprocessor
and moves the data between the FOC IP and the peripherals.

Note: Alternatively, the design includes software implementations of the FOC algorithm with
the same FOC functionality. You can select which implementation to run using the
Debug GUI. In all FOC implementations, the design performs the reverse Clarke
transform as part of the SVM function in software.
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FOC controls a motor's sinusoidal 3-phase currents in real time to create a smoothly
rotating magnetic flux pattern, where the frequency of rotation corresponds to the
frequency of the sine waves. FOC controls the current vector to keep:

• The torque-producing quadrature current, Iq, at 90 degrees to the rotor magnet
flux axis

• The direct current component, Id, (commanded to be zero) inline with the rotor
magnet flux.

The FOC algorithm:

1. Converts the 3-phase feedback current inputs and the rotor position from the
encoder into quadrature and direct current components using Clarke and Park
transforms.

2. Uses these current components as the inputs to two proportional and integral (PI)
controllers running in parallel to adjust the direct current to zero and the
quadrature current to the desired torque.

3. Converts the direct and quadrature voltage outputs from the PI controllers back to
3-phase voltages with inverse Clarke and Park transforms.

The FOC algorithm includes:

• Forward and reverse Clarke and Park transforms

• Direct and quadrature current

• Proportional integral (PI) control loops

• Sine and cosine

• Saturate functions

9.9.1. DSP Builder for Intel FPGAs Model for the Drive-On-Chip Designs

The top-level model is a simple dummy testbench with constant inputs of the correct
arithmetic types to control hardware generation, which includes the FOC algorithm
model.

9. Functional Description of the Drive-On-Chip Design Example

683466 | 2022.05.15

Send Feedback AN 669: Drive-On-Chip Design Example for Cyclone V Devices

67

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20AN%20669:%20Drive-On-Chip%20Design%20Example%20for%20Cyclone%20V%20Devices%20(683466%202022.05.15)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


Figure 46. DSP Builder for Intel FPGAs Model
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The FOC algorithm comprises the FOC algorithm block and a latch block for
implementing the integrators necessary for the PI controllers in the FOC algorithm.
DSP Builder for Intel FPGAs implements the latches outside because of limitations of
the folding synthesis.

The design includes fixed-point and floating-point models that implement the FOC
algorithm.

Each model calls a corresponding .m setup script during initialization to set up the
arithmetic precision, folding factor, and target clock speed. The folding factor is set to
a large value to minimize resource usage.

Table 18. Default settings in Setup Script

Model Folding Factor Clock Speed (MHz) Input Precision Output Precision

Fixed point 500 100 sfix16En10 sfix32En10

Floating point 500 100 sfix32En10 sfix32En10

The following models generate the FOC block including the Avalon memory-mapped
interface:

• DFf_float_alu_av.slx for floating-point designs

• DFf_fixp16_alu_av.slx for fixed-point designs

A Simulink library model contains the main FOC algorithm code, which the other
models refer to:

• foc_blocks.slx
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9.9.2. Avalon Memory-Mapped Interface

The Drive-On-Chip Design DSP Builder for Intel FPGAs-generated VHDL has a signal
interface that matches the connections in Simulink. Feedback currents, position
feedback, torque command, and gain parameters are all parallel inputs into the
system and voltage commands are parallel outputs.

To allow direct connectivity in Qsys, the top-level DSP Builder for Intel FPGAs design
adds blocks to terminate the parallel inputs and outputs and handshaking logic with an
Avalon memory-mapped register map.

Figure 47. FOC Model integrated in Simulink with Avalon-MM Register Map
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DSP Builder for Intel FPGAs generates a .h file that contains address map information
for interfacing with the DSP Builder for Intel FPGAs model.

To run the DSP Builder for Intel FPGAs model as part of the drive algorithm, a C
function passes the data values between the processor and DSP Builder for Intel
FPGAs. The handshaking logic ensures synchronization between the software and
hardware. The software sets up any changes to hardware parameters such as PI
gains, writes new feedback currents, position feedback and torque command input
data before starting the DSP Builder for Intel FPGAs calculation. The software then
waits for the DSP Builder for Intel FPGAs calculation to finish before reading out the
new voltage command data.

The ISR that runs the FOC algorithm calls the C function with an option to switch
between software and DSP Builder for Intel FPGAs implementations at runtime.

Related Information

Avalon Interface Specification

9.9.3. About DSP Builder for Intel FPGAs

DSP Builder for Intel FPGAs supports bit-accurate simulation and VHDL generation of
the full range of fixed-point and floating-point data types available in Simulink.
Floating-point data types give a high dynamic range, avoid arithmetic overflows, and
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avoid the manual floating- to fixed-point conversion and scaling steps necessary in
algorithm development. You can optimize the data types to adjust hardware usage
and calculation latency, and run Simulink simulations to confirm adequate
performance.

After you develop the algorithm in Simulink, DSP Builder can automatically generate
pipelined HDL that it targets and optimizes to the chosen FPGA device. You can use
this VHDL in a HDL simulator such as ModelSim* to verify the generated logic versus
Simulink and in the Quartus Prime software to compile the hardware. DSP Builder for
Intel FPGAs gives instant feedback of the VHDL's logic utilization and algorithm latency
in automatically generated Simulink reports.

9.9.4. DSP Builder for Intel FPGAs Folding

DSP Builder for Intel FPGAs generates flat parallel models that can receive and process
new input data on every clock pulse. However, designs that have a much lower sample
rate than the FPGA clock rate, such as this FOC design (16 kHz versus 100 MHz), can
use the DSP Builder for Intel FPGAs folding feature to trade off an increase in
algorithm latency for a decrease in the FPGA resources. This feature allows the design
to use as much hardware parallelism as necessary to reach the target latency with the
most cost-effective use of FPGA resources without making any changes to the
algorithm.

The DSP Builder for Intel FPGAs folding feature reuses physical resources such as
multipliers and adders for different calculations with the VHDL generation
automatically handling the complexity of building the time division multiplexed (TDM)
hardware.

Figure 48. Unfolded and Folded Hardware Examples
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9.9.5. DSP Builder for Intel FPGAs Model Resource Usage

For the Drive-On-Chip Design, Intel compared the FOC algorithm as a single precision
floating-point model to a model that uses the folding feature. When you use folding,
the model uses fewer logic elements (LEs) and multipliers but has an increase in
latency. In addition, a fixed-point model uses significantly fewer LEs and multipliers
and has lower latency than the floating-point model.

Intel compared floating- and fixed-point versions of the FOC algorithm with and
without folding. In addition, Intel compared using a 26-bit (17-bit mantissa) instead of
standard single-precision 32-bit (23-bit mantissa) floating point implementation. 26-
bit is a standard type within DSP Builder for Intel FPGAs that takes advantage of the
FPGA architecture to save FPGA resources if this precision is sufficient.
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Cyclone V devices use ALMs instead of LEs (one ALM is approximately two LEs plus
two registers) and DSP blocks instead of multipliers (one DSP block can implement
two 18-bit multipliers or other functions).

Table 19. Resource Usage Comparison for Cyclone V Devices

Design Folding Precision ALMs DSPs Latency (us) M10K

Floating-point No 32 9968 31 0.99 19

Floating-point Yes 32 3840 4 1.77 1

Floating-point No 26 8995 31 0.99 15

Floating-point Yes 26 3634 4 1.75 3

Fixed-point No 16 1979 24 0.22 2

Fixed-point Yes 16 2510 1 1.99 2

The results show:

• 26-bit floating-point precision uses fewer resources because datapaths are
narrower and simpler with reduced precision.

• Fixed-point designs use significantly fewer resources than floating-point designs.
Typically, implement fixed-point designs if you do not require the high dynamic
range that floating-point offers. However, floating-point designs avoid arithmetic
overflow during algorithm development and tuning.

• Fixed-point designs can achieve a processing latency down to 0.1 μs, which is
ideal for designs that require very high update frequencies.

• Folded designs use significantly fewer resources than designs without folding.
Folding increases latency to around 1 μs, which is still acceptable for the control
loop.

9.9.6. DSP Builder for Intel FPGAs Design Guidelines

Use these design guidelines to reduce FPGA resource usage with folding.

In your design:

• Use the variable precision support in DSP Builder for Intel FPGAs. Instead of using
a 32-bit datapath, investigate the algorithm and reduce the numeric format as
much as possible. Also keep sufficient accuracy to represent the range of allowed
data values.

• Use components that use fewer FPGA resources. For example, sin(x) and cos(x)
blocks require a range reduction stage. Use the smaller sin(pi*x) and cos(pi*x).

• Use fewer different components to enable resource reuse. For example,
restructure a sin(pi*x) and a cos(pi*x) into a sin(pi*x) and sin(pi*(0.5-x)).

• Ensure that the select line of a multiplexer does not use more bits than necessary.
For example, for a 2:1 multiplexer, the select line should be 1 bit.
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9.9.7. Generating VHDL for the DSP Builder Models for the Drive-On-Chip
Reference Designs

1. Start DSP Builder for Intel FPGAs.

2. Change the directory to the ip\dspba.

3. If you want a different numeric precision, edit the setup_<Simulink Model>.m file
corresponding to the model before opening it.

4. Load the model. Check the status of the orange DSP Builder folding block. If the
model includes it, folding is enabled. If it is removed or commented out, the model
does not use folding.

5. On the Simulation menu, click Start.

DSP Builder for Intel FPGAs generates the VHDL files in ip\dspba\rtl (for Cyclone
V devices).

9.10. FFTs

FFT0 and FFT1 correspond to the two 4,096pt FFT blocks that the design implements
on the SoC for vibration suppression. The design provides two FFTs to enable
immediate comparison between the FFTs of different internal control signals. Each
calculates an FFT on the last 4,096 samples input to it. The number of samples
between each new calculation is configurable. The design uses 64 samples between
each new calculation, so each new FFT is based on the same data set as the previous
one except for 64 new points. Given the sample rate of 16kHz, the design produces
new FFT data sets at 250Hz. Thus vibration detection can react quickly, before
equipment is damaged.

Figure 49. FFT Overlapping Data Sets
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9.10.1. Servo FFTs

The design uses two parallel instantiations of the DSP Builder Advanced Blockset servo
FFT. The servo FFT is a folded FFT design that uses minimal FPGA resources but
sufficient performance for typical industrial drive applications.

Table 20. FFT Resource Usage

Device Logic Memory Other

Cyclone V 550 ALMs 29 M9K 2 DSP blocks
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The processing time with a 100-MHz clock is around 0.6ms including the time to clock
data out of the FFT block again. The processing time for two parallel FFTs is the same.
You may choose other FFT implementations for the FPGA for faster processing times if
required, at the expense of FPGA resources.

9.10.1.1. Running test_servofft.mdl

1. When you run the test_servofft.mdl Simulink model in the project dspba
directory, setup_test_servofft.m runs the set up configuration parameters for
the FFT and imports sampled motor current data from the input data for the
simulation file (test_servofft_sampledata.csv).

2. DSP Builder generates the HDL code.

3. Simulink runs the simulation, using the sampled current data from
test_servofft_sampledata.csv as FFT input.

4. analyze_test_servofft.m collects the simulation output and creates some
MATLAB plots to verify correct calculation. It compares the simulated servo FFT
output with that from the MATLAB FFT and with output data collected from servo
FFT running in hardware.

9.10.2. Vibration Suppression

The standard FOC loop has a configurable digital filter to enable you to adjust the loop
frequency response, which avoids exciting identified vibrations. An outer control loop
analyzes motor feedback signals using FFTs to identify any vibrations that may be
present. If the design detects vibrations, it automatically adjusts the control gains in
the standard control loop and the filter settings to minimize the vibration. The
reference design does not include automatic detection and suppression. For detection
use System Console; for suppression manually configure the IIR filter.
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Figure 50. Control Loop Flow Diagram for Vibration Suppression
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Methods of automatically tuning filter and control gains depend on:

• Knowledge of the mechanical and electrical properties of the mechanisms that the
motor drives

• The effects of different filter settings on the overall control response

9.10.3. Command Waveform

The command waveform generator provides repeating waveforms. The design uses
these waveforms for developing the overall control system including any vibration
suppression features. The waveforms generate repeatable behavior for given control
system settings.

You can choose the waveform shape, period (expressed as a number of 16 kHz
samples), and amplitude.

9.10.4. IIR Filter

The design applies an IIR filter to the FOC voltages Vd and Vq before it applies them
to the motor.
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The IIR filter is a configurable second-order digital filter, based on the second-order

continuous time transfer function (in Laplace notation):

The design converts the continuous time formulation to a discrete-time formulation
using a combination of the Tustin (bilinear) transformation and frequency prewarping,
which ensures that the discrete time and continuous time filter characteristics match
at a specified frequency Ω:

The design applies prewarping to the denominator terms with Ω = Ωd and to the
numerator terms with Ω = Ωn, which ensures that the filter preserves the corner
frequencies of Ωd and Ωn after the transformation.

The design applies the IIR filter to the Vd and Vq voltage signals. These signals are
the final outputs of the linear control system before the trigonometric transformation
to stator-fixed voltages (Vα and Vβ) and the space vector modulation (SVM)
conversion to transistor gate signals.

The IIR filter is integrated into the FOC algorithm. Different DSP modes use different
implementations of the FOC algorithm. Each implementation of the FOC algorithm
includes a matching implementation of the IIR filter.

9.10.5. IIR Filter Tuning Parameters

Table 21. IIR Filter Tuning Parameters

Parameter Description

Ωd Corner frequency (rad/s) above which the denominator response magnitude begins to decrease.

ζd Damping factor that determines the sharpness of the corner at Ωd; ζd < sqrt(0.5) results in a filter
response peak (filter resonance) around Ωd, whereas ζd > sqrt(0.5) gives a more gradual (more
strongly damped) transition with no peak.

Ωn Corner frequency (rad/s) above which the numerator response magnitude begins to increase.

ζn Damping factor that determines the sharpness of the corner at Ωn; ζn < sqrt(0.5) results in a filter
response trough around Ωn, whereas ζn > sqrt(0.5) gives a more gradual transition with no trough.

Use these four parameters to create different filter response shapes. For vibration
suppression, use a notch characteristic to decrease the system gain only around the
frequency of interest. Set Ωn = Ωd and ζn < ζd. The gain at Ωn = Ωd is then equal to
ζn/ ζd
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9.10.6. IIR Filter Examples

Table 22. Exanple IIR Filters

Description Ωd (Hz) Ωn (Hz) ζd
(nondimensional

)

ζn
(nondimensional

)

Sharp notch with 10x gain reduction at 2 kHz 2,000 2,000 0.3 0.03

Wide notch with 10x gain reduction at 1 kHz 1,000 1,000 100 10

Figure 51. Bode Plot—Sharp Notch with 10x Gain Reduction at 2 kHz
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Figure 52. Bode Plot, Wide Notch with 10x Gain Reduction at 1 kHz

9.10.7. Vibration Detection

Raw FFT output is a complex-valued array of 4,096 points. The DMA peripheral in the
SoC transfers this data from the FPGA part of the SoC to processor RAM. Software
converts the real and imaginary parts to FFT magnitude (squared) and then applies a
basic peak detection algorithm. A peak is the largest FFT magnitude value between
two specified frequency bounds. Peak detection allows you to identify and read peak
values from the FFT magnitude graphs in System Console.

9.11. DEKF Technique for Battery Management

The battery management system demonstrates battery state of charge (SOC)
estimation in an FPGA-based real-time control platform. It uses a dual extended
Kalman filter (DEKF) algorithm. In the DEKF technique, the design simultaneously
executes two cooperating Kalman filters for nonlinear systems: one to estimate the
states and the other to estimate the parameters. For more information, refer to DEKF
Technique in AN 773: Drive-On-Chip Design Example for Intel MAX 10 Devices.

9.12. Signals

The signals connect various blocks in the Drive-On-Chip Design Example.

9. Functional Description of the Drive-On-Chip Design Example

683466 | 2022.05.15

Send Feedback AN 669: Drive-On-Chip Design Example for Cyclone V Devices

77

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20AN%20669:%20Drive-On-Chip%20Design%20Example%20for%20Cyclone%20V%20Devices%20(683466%202022.05.15)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


Table 23. Six-Channel PWM Interface Signals

Signal Name Direction Description

Avalon-MM Interface Signals

clk Input PWM and system clock input

reset_n Input System reset signal, active low

avs_read_n Input Avalon-MM read strobe, active low

avs_write_n Input Avalon-MM write strobe, active low

avs_address[3:0] Input Avalon-MM address bus

avs_writedata[31:0] Input Avalon-MM write data bus

avs_readdata[31:0] Output Avalon-MM read data bus

Conduit Signals

pwm_enable Input PWM enable from drive system monitor

en_upper Input Upper switch enable from drive system monitor

en_lower Input Lower switch enable from drive system monitor

u_h Output Motor phase U upper gate drive

u_l Output Motor phase U lower gate drive

v_h Output Motor phase V upper gate drive

v_l Output Motor phase V lower gate drive

w_h Output Motor phase W upper gate drive

w_l Output Motor phase W lower gate drive

sync_in Input Synchronization signal for multiple PWM modules

sync_out Output Synchronization signal for multiple PWM modules

start_adc Output ADC start conversion signal

Table 24. DC Link Monitor Signals

Signal Name Direction Description

Avalon-MM Interface Signals

clk Input FPGA system clock input

clk_adc Input ADC clock input

reset_n Input System reset signal, active low

avs_read_n Input Avalon-MM read strobe, active low

avs_write_n Input Avalon-MM write strobe, active low

avs_address[3:0] Input Avalon-MM address bus

avs_writedata[31:0] Input Avalon-MM write data bus

avs_readdata[31:0] Output Avalon-MM read data bus

avs_irq Output Avalon interrupt

Conduit Signals

continued...   
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Signal Name Direction Description

sync_dat Input Sigma-delta ADC bit stream

dc_link_enable Input Enable

overvoltage Input Overvoltage status

undervoltage Output Undervoltage status

chopper Output Chopper circuit gate drive

Table 25. Drive System Monitor Interface Signals

Signal Name Direction Description

Avalon-MM Interface Signals

clk Input FPGA system clock input

reset_n Input System reset signal, active low

avs_read_n Input Avalon-MM read strobe, active low

avs_write_n Input Avalon-MM write strobe, active low

avs_address[3:0] Input Avalon-MM address bus

avs_writedata[31:0] Input Avalon-MM write data bus

avs_readdata[31:0] Output Avalon-MM read data bus

Conduit Signals

overcurrent Input Overcurrent status

overvoltage Input Overvoltage status

undervoltage Input Undervoltage status

chopper Input Chopper status

dc_link_clk_err Input Clock monitor status

igbt_err Input IGBT error status

error_out Output Error output

overcurrent_latch Output Latched overcurrent status

overvoltage_latch Output Latched overvoltage status

undervoltage_latch Output Latched undervoltage status

dc_link_clk_err_latch Output Latched clock monitor status

igbt_err_latch Output Latched IGBT error status

chopper_latch Output Latched chopper status

pwm_control[2:0] Output PWM control

Table 26. Quadrature Encoder Interface Signals

Signal Name Direction Description

Avalon-MM Interface Signals

clk Input FPGA system clock input

reset_n Input System reset signal, active low
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Signal Name Direction Description

avs_read_n Input Avalon-MM read strobe, active low

avs_write_n Input Avalon-MM write strobe, active low

avs_address[3:0] Input Avalon-MM address bus

avs_writedata[31:0] Input Avalon-MM write data bus

avs_readdata[31:0] Output Avalon-MM read data bus

Conduit Signals

strobe Input Capture strobe

QEP_A Input Quadrature phase A

QEP_B Input Quadrature phase B

QEP_I Input Quadrature index

Table 27. Sigma-Delta ADC Interface Signals

Signal Name Direction Description

Avalon-MM Interface Signals

clk Input FPGA system clock input

clk_adc Input ADC clock input

reset_n Input System reset signal, active low

avs_read_n Input Avalon-MM read strobe, active low

avs_write_n Input Avalon-MM write strobe, active low

avs_address[3:0] Input Avalon-MM address bus

avs_writedata[31:0] Input Avalon-MM write data bus

avs_readdata[31:0] Output Avalon-MM read data bus

avs_irq Output Interrupt request

Conduit Signals

start Input Start conversion signal

sync_dat_u Input Phase U sigma-delta bitstream

sync_dat_v Input Phase V sigma-delta bitstream

sync_dat_w Input Phase W sigma-delta bitstream

overcurrent Output Overcurrent status

Table 28. FFT IP

SignalName Direction Description

Avalon Memory-Mapped Interface Signals

clk Input FPGA system clock input

areset Input System reset signal, active high

h_areset Input Reset signal for Avalon memory-mapped interface, active high

busIn_read Input Avalon memory-mapped read strobe, active high
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SignalName Direction Description

busIn_write Input Avalon memory-mapped write strobe, active high

busIn_address[5:0] Input Avalon memory-mapped address bus

busIn_writedata[31:0] Input Avalon memory-mapped write data bus

busOut_readdata[31:0] Output Avalon memory-mapped read data bus

busOut_readdatavalid Output Avalon memory-mapped read data valid

Conduit Signals for FFT results output

qreal[31:0] Output FFT output real part

qimag[31:0] Output FFT output imaginary part

exponent[4:0] Output Exponent of FFT output real/imaginary part

busy_fft Output FFT processing busy flug, active high

exp_error Output Error flag, active high

qv_fft Output FFT output data valid

Table 29. FFT buffer

Signal Name Direction Description

Avalon memory-mapped buffer memory interface signals

avs_clk Input FPGA system clock input

reset_n Input System reset signal, active low

avs_read_n Input Avalon memory-mapped read strobe, active low

avs_write_n Input Avalon memory-mapped write strobe, active low

avs_address[11:0] Input Avalon memory-mapped address bus

avs_writedata[63:0] Input Avalon memory-mapped write data bus

avs_readdata[63:0] Output Avalon memory-mapped read data bus

avs_bytenable[7:0] Input Avalon memory-mapped byte enable

Avalon memory-mapped control and status agent interface signals

avalon_csr_slave_read Input Avalon memory-mapped CSR slave read strobe, active high

avalon_csr_slave_readdata[31:0] Output Avalon memory-mapped CSR slave read data

avalon_csr_slave_write Input Avalon memory-mapped CSR slave write strobe, active high

avalon_csr_slave_writedata[31:0] Input Avalon memory-mapped CSR slave write data

Conduit Signals for FFT result data input

dspba_export_qreal_exp [31:0] Input FFT Output real part

dspba_export_qimag_exp [31:0] Input FFT output imaginary part

dspba_export_exponent_exp [4:0] Input Exponent of FFT output real/imaginary part

dspba_export_busy_fft_exp Input FFT processing busy flug, active high

dspba_export_exp_error_exp Input Error flag, active high

dspba_export_qv_fft_exp Input FFT output data valid
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Table 30. DC-DC Converter Interface Signals

Signal Name Direction Description

Avalon memory-mapped interface signals

avs_clk Input 10MHz clock input

reset_n Input System reset signal, active low

avs_read_n Input Avalon-MM read strobe, active low

avs_write_n Input Avalon-MM write strobe, active low

avs_address[4:0] Input Avalon-MM address bus

avs_writedata[31:0] Input Avalon-MM read data bus

avs_readdata[31:0] Output Avalon-MM write data bus

Conduit Signals

enable_in Input Enable input

bidir_en_n Input Bidirectional conversion enable

fault Input Fault input. If the design asserts the fault input, it clears the
enable bit of the control register, and turns off the DC-DC
converter. The design keeps the enable bit clear, and does
not set again, until the fault input is negated.

pwm_sync_n Input Synchronization signal

gate_a_h Output Phase 0 upper transistor gate drive

gate_a_l Output Phase 0 lower transistor gate drive

gate_b_h Output Phase 1 upper transistor gate drive

gate_b_l Output Phase 1 lower transistor gate drive

dc_dc_on Output DC-DC status

overvoltage Output Overvoltage error

overcurrent Output Overcurrent error

timeout_latch Output Sample timeout

sync_dat_i_pase_a Input Phase 0 current feedback sigma-delta bitstream

sync_dat_i_pase_b Input Phase 1 current feedback sigma-delta bitstream

sync_dat_v_out Input Voltage feedback sigma-delta bitstream

clk_adc Input ADC clock input

9.13. Registers

The Drive-on-Chip Design Example contains many registers that you can set.

Table 31. Six-Channel PWM Interface Control and Status Registers
Write reserved bits as zero and read as zero.

Address Name Bits Description Reset Value Access

0x00 - - Reserved - -

0x04 pwm_u [31:15] Reserved - -
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Address Name Bits Description Reset Value Access

[14:0] phase U PWM switching threshold in PWM clocks 0x0 RW

0x08 pwm_v [31:15] Reserved - -

[14:0] phase V PWM switching threshold threshold in PWM clocks 0x0 RW

0x0C pwm_w [31:15] Reserved - -

[14:0] phase W PWM switching threshold threshold in PWM clocks 0x0 RW

0x10 max [31:15] Reserved - -

[14:0] PWM maximum count threshold in PWM clocks 0x0 RW

0x14 block [31:8] Reserved - -

[7:0] PWM blocking (dead time) register threshold in PWM clocks 0x0 RW

0x18 trigger_up [31:15] Reserved - -

[14:0] PWM up count trigger for ADC threshold in PWM clocks 0x0 RW

0x1C trigger_down [31:15] Reserved - -

[14:0] PWM down count trigger for ADC threshold in PWM clocks 0x0 RW

0x20 gate [31:6] Reserved - -

[5] Phase U lower transistor gate signal 0x0 R

[4] Phase U upper transistor gate signal 0x0 R

[3] Phase V lower transistor gate signal 0x0 R

[2] Phase V upper transistor gate signal 0x0 R

[1] Phase W lower transistor gate signal 0x0 R

[0] Phase W upper transistor gate signal 0x0 R

0x24 carrier [31:16] Reserved - -

[15:0] PWM count value threshold in PWM clocks 0x0 R

0x28 multi_cycle [31:4] Reserved - -

[3:0] Cycles to skip for ADC sample strobes 0x0 RW

Table 32. DC Link Monitor Interface Control and Status Registers
Write reserved bits as zero and read as zero.

Address Name Bits Description Reset Value Access

0x00 - - Reserved - -

0x04 offset [31:16] Reserved - -

[15:0] Offset. A value of 16384 corresponds to a zero offset. 0x0 RW

0x08 k_64 [31:1] Reserved - -

[0] sinc3 filter decimation rate. When set to 0, the sinc3
decimation rate is M=64; when set to 1, the sinc3
decimation rate is M=128.

0x0 RW

0x0C ref_disable [31:16] Reserved - -
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Address Name Bits Description Reset Value Access

[15:0] DC-link voltage disable level. This register provides the
maximum allowable voltage for link voltage. If the
maximum value is exceeded the overvoltage output is
driven, to shut down the system.

0x0 RW

0x10 link_ref [31:16] Reserved - -

[15:0] DC-link chopper voltage level. The chopper IGBT transistor
is turned on when the DC-link voltage exceeds this value.

0x0 RW

0x14 bottom_ref [31:16] Reserved - -

[15:0] DC-link undervoltage reference level. If the link voltage falls
below the reference level the undervoltage output is driven.

0x0 RW

0x18 brake_t [31:11] Reserved - -

[10:0] This register is not used. 0x0 RW

0x1C brake_max_level [31:16] Reserved - -

[15:0] This register is not used. 0x0 RW

0x20 dc_link [31:16] Reserved - -

[15:0] Current link voltage reading 0x0 R

0x24 brake_level [31:16] Reserved - -

[15:0] This register is not used. 0x0 R

0x28 status [31:3] Reserved - -

[2] DC link overvoltage status 0x0 R

[1] DC link undervoltage status 0x0 R

[0] Chopper gate signal status 0x0 R

Table 33. Drive System Monitor Control and Status Registers
Write reserved bits as zero and read as zero. R/W1C bits are read, write a 1 to clear the bit

Address Name Bits Description Reset Value Access

0x00 control [31:3] Reserved - -

[2:0] Control. Write to this register to request a change of state in the drive
system monitor.

0x0 RW

0x04 status [31:12] Reserved - -

[11:9] Current DSM state. 0x0 R

[8] PWM control, upper PWM enable - -

[7] PWM control, lower PWM enable 0x0 R

[6] PWM control, PWM enable - -

[4] IGBT error 0x0 R/W1C

[3] ADC clock status - R/W1C

[2] Undervoltage status 0x0 R/W1C

[1] Overvoltage status - R/W1C

[0] Overcurrent status 0x0 R/W1C
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Table 34. Quadrature Encoder Interface Control and Status Registers
Write reserved bits as zero and read as zero.

Address Name Bits Description Reset Value Access

0x00 control [31:3] Reserved. - -

[2] direction bit. Reverses the count direction when set. 0x0 RW

[1] index_reset_en bit. Count will reset on index pulse if this bit is
set.

0x0 RW

[0] index_capture_en bit. Count will be captured in index capture
reg, when index pulse occurs, if this bit is set.

0x0 RW

0x04 count capture [31:0] Captures current count on each strobe. 0x0 R

0x08 maximum count [31:0] Maximum count. Count will reset to zero when it reaches this
value.

0x3FFF RW

0x0C count [31:0] Current count value. 0x0 RW

0x10 index capture [31:0] Captures current count when index pulse occurs if
index_capture_en bit is set.

0x0 R

Table 35. Sigma-Delta ADC Interface Control and Status Registers
Write reserved bits as zero and read as zero.

Address Name Bits Description Reset Value Access

0x0 - - Reserved - -

0x04 offset_u [31:16] Reserved. - -

[15:0] Offset for phase U. A value of 32,768 corresponds to 0 offset. 0x0 RW

0x08 offset_w [31:16] Reserved. - -

[15:0] Offset for phase W. A value of 32,768 corresponds to 0 offset. 0x0 RW

0x0C i_peak [31:10] Reserved. - -

[9:0] Overcurrent detection threshold. 0x0 RW

0x10 d [31:3] Reserved. - -

[2] sinc3 filter decimation rate. When set to 0, the sinc3
decimation rate is M=128 for the control loop and M=16 for
overcurrent detection; when set to 1, the sinc3 decimation
rate is M=64 for the control loop and M=8 for the overcurrent
detection.

0x0 RW

[1] Overcurrent enable 0x0 RW

[0] Overvoltage enable 0x0 RW

0x14 irq_ack [31:1] Reserved. - -

[0] 0x0 W1C

0x18 status [31:5] Reserved. - -

[4] 0x0 R

[3] 0x0 R

[2] Overcurrent for phase U 0x0 R

[1] Overcurrent for phase W 0x0 R
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Address Name Bits Description Reset Value Access

[0] Overcurrent for any phase 0x0 R

0x1C i_u [31:10] Reserved. - -

[9:0] Current in phase U. 0x0 R

0x20 i_w [31:10] Reserved. - -

[9:0] Current in phase W. 0x0 R

0x24 i_peak [31:10] Reserved. - -

[9:0] Overcurrent detection threshold. 0x0 RW

0x28 i_v [31:10] Reserved. - -

[9:0] Current in phase V. 0x0 R

0x2C offset_v [31:16] Reserved. - -

[15:0] Offset for phase V. A value of 32,768 corresponds to 0 offset. 0x0 RW

0x2C Overcurrent_u [31:10] Reserved. - -

[9:0] Overcurrent value for phase U 0x0 R

0x2C Overcurrent_v [31:10] Reserved. - -

[9:0] Overcurrent value for phase V 0x0 R

0x2C Overcurrent_w [31:10] Reserved. - -

[9:0] Overcurrent value for phase W 0x0 R

Table 36. DC-DC Converter Control and Status Registers
Write reserved bits as zero and read as zero

Address Name Bits Description Reset Value Access

0x00 control [31:5] Reserved - -

[4] State of REGEN_EN signal from the power board - R

[3] Reserved - -

[2] Enable regeneration 0 RW

[1] Enable closed loop mode 0 RW

[0] Enable Dc-DC gated with enable_in input 0 RW

0x04 cmd_dc [31:14] Reserved - -

[13:0] Commanded DC-DC output level in 1V increments 0 RW

0x08 fault_reg [31:6] Reserved - -

[5] Input overvoltage detected 0 RW

[4] Input undervoltage detected 0 RW

[3] Output overvoltage detected 0 RW

[2] Output undervoltage detected 0 RW

[1] Input overcurrent detected 0 RW

[0] Output overcurrent detected 0 RW

0x0C - - Reserved 0 -
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Address Name Bits Description Reset Value Access

0x10 duty [31:14] Reserved - -

[13:0] Duty cycle for open loop mode, 0 – 100 50 RW

0x14 freq [31:14] Reserved - -

[13:0] Frequency of operation, kHz 64 RW

0x18 - - Reserved - -

0x1C - - Reserved - -

0x20 fb_current_a [31:13] Reserved - -

[12:0] Phase 0 current feedback sample, 100 = 1A 0 RW

0x24 fb_current_b [31:13] Reserved - -

[12:0] Phase 1current feedback sample, 100 = 1A 0 RW

0x28 fb_voltage [31:13] Reserved - -

[12:0] DC-DC output voltage feedback sample, 40 = 1V 0 RW

0x2C - - Reserved 0 -

0x30 offset_fb_current_a [31:16] Reserved - -

[15:0] Phase 0 current feedback ADC offset 0x8000 RW

0x34 offset_fb_current_b [31:16] Reserved - -

[15:0] Phase 1 current feedback ADC offset 0x8000 RW

0x38 offset_fb_voltage [31:16] Reserved - -

[15:0] DC-DC output voltage feedback ADC offset 0x8000 RW

0x3C - - Reserved 0 -

0x40 pgain_voltage [31:14] Reserved - -

[13:0] P gain coefficient for voltage control loop * 100
[AC TODO] resolution? Scale?

300 RW

0x44 igain_voltage [31:14] Reserved - -

[13:0] I gain coefficient for voltage control loop * 1e-7 (1/
avs_clk)

4000 RW

0x48 pgain_current [31:14] Reserved - -

[13:0] P gain coefficient for current control loop * 1000 20 RW

0x4C igain_current [31:14] Reserved - -

[13:0] I gain coefficient for current control loop * V 25 RW

Table 37. FFT IP Registers
Write reserved bits as zero and read as zero. R/W1C bits are read, write a 1 to clear the bit

Address Name Bits Description Reset Value Access

0x00 busy [31:1] Reserved - -

[0] FFT data input Not ready, busy flag. 0x0 R

0x04 start [31:1] Reserved - -

continued...   

9. Functional Description of the Drive-On-Chip Design Example

683466 | 2022.05.15

Send Feedback AN 669: Drive-On-Chip Design Example for Cyclone V Devices

87

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20AN%20669:%20Drive-On-Chip%20Design%20Example%20for%20Cyclone%20V%20Devices%20(683466%202022.05.15)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


Address Name Bits Description Reset Value Access

[0] Start command. When write a new input data for FFT toggle this
bit 0 to 1.

0x0 RW

0x40 SIZE_CFG [31:4] Reserved - -

[3:0] Power of 2 of FFT size. When set n, FFT size is 2^n. RW

0x80 D_input [31:16] Reserved - -

[15:0] Input data for FFT RW

Table 38. FFT buffer memory Registers
Write reserved bits as zero and read as zero. R/W1C bits are read, write a 1 to clear the bit

Address Name Bits Description ResetValue Access

0x0000 fft_result[0] [31:0] Real part of fft_result[0] 0 R

0x0004 fft_result[0] [31:0] Imaginary part of fft_result[0] 0 R

0x0008 fft_result[1] [31:0] Real part of fft_result[1] 0 R

0x000C fft_result[1] [31:0] Imaginary part of fft_result[1] 0 R

: :

0x7FF8 fft_result[4095] [31:0] Real part of fft_result[4095] 0 R

0x7FFC fft_result[4095] [31:0] Imaginary part of fft_result[4095] 0 R

Table 39. FFT buffer Control and Status Registers

Write reserved bits as zero and read as zero. R/W1C bits are read, write a 1 to clear the bit

Address Name Bits Description Reset Value Access

0x0000 status [31:2] Reserved - -

[1] FFT IP busy. When 1, FFT IP is processing data. 0 R

[0] Data Ready. FFT buffer ready to read. When all FFT outputs are stored
in the buffer, this bit set 1 by hardware. Software should set 0, when all
buffer contents are read out. Only if this bit set 0, hardware starts
writing FFT output to the buffer.

0 RW
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10. Achieving Timing Closure on a Motor Control Design
Intel® Quartus® Prime may not achieve full timing closure when it first compiles and
fits this designs.

You must assume worst-case timing parameters over a wide range of temperature,
which is good practice for a commercial design. If you run this design at room
temperature, it is unlikely that real timing violations occur. To achieve full timing
closure with Intel Quartus Prime, you may include additional pipeline registers.
However, the place-and-route process is sensitive to an initial seed value and the
result of different seeds is not easy to predict. Before optimizing the design, try the
seed sweep function with many different seed values in case the design immediately
fits.

1. In Intel Quartus Prime, select Tools ➤ Launch Design Space Explorer II.

Design space Explorer opens in a seaparate window.

2. For a basic seed sweep use the following settings:

a. In Setup, select Local.

b. In Exploration, select Design exploration, exploration mode: Seed
Sweep Only, create 10 seeds.

c. Click Start to run.

Figure 53. Exploration window
Use Results to view when all are finished
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Figure 54. Result window

d. Calculate the seed number from the exploration point name. It is the _number
plus 1. In this example, the best seed will be 2(dse1_2) + 1 = 3.

3. Select Assignments ➤ Settings.

4. In complier settings, click Advanced settings (Fitter)….

5. Update seed value Fitter Initial Placement Seed 3.

10.1. Optimizing Motor Control Designs

1. In Intel Quartus Prime, Assignments ➤ Settings.

2. In complier settings, change the default Optimization mode from Balanced
(Normal flow), to either Performance (High effort – increases run time) or
Performance (High effort – increases run time). If the design density is
already very high, then use Performance (High effort – increases run time)
because Performance (High effort – increases run time) may cause congestion.

3. In complier settings, click Advanced settings (Fitter)…and change these
settings to improve timing.

• Change Router Effort Multiplier from 2.0 to 4.0

• Turn on Perform Clocking Topology Analysis During Routing

• Turn on Eco Optimize Timing

• Turn on Final Placement Optimization Always Physical Synthesis
Register Duplication

• Turn on Physical Synthesis Asynchronous Signal Pipelining

10. Achieving Timing Closure on a Motor Control Design

683466 | 2022.05.15

AN 669: Drive-On-Chip Design Example for Cyclone V Devices Send Feedback

90

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20AN%20669:%20Drive-On-Chip%20Design%20Example%20for%20Cyclone%20V%20Devices%20(683466%202022.05.15)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


11. Design Security Recommendations
Follow these recommendations if you use the Drive-On-Chip Design Example as the
basis for a commercial product:

• Add more checks on current, voltage, and gain values in the design to ensure all
the parameters are in the correct range.

• Analyze the security risk of incorrect use of the JTAG interface while implementing
the design. Incorrect use of the JTAG interface can cause system malfunction and
damage the power electronics, motors, or machinery that the design drives. It
might even create a hazard to people working with the design.

• Ensure you follow guidelines for secure use of JTAG to protect the system from
any unauthorized write or read accesses.
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12. Reference Documents for the Drive-on-Chip Design
Example

Related Information

• White Paper: Motor Control Designs with an Integrated FPGA Design Flow

• DC-DC Converter Reference Design

• Tandem Motion-Power 48 V Board Reference Manual

• Battery Management System Reference Design
The Battery Management System (BMS) Reference Design demonstrates
battery state of charge (SOC) estimation in an FPGA-based real-time control
platform that you can extend to include other BMS functionality such as battery
state-of-health monitoring and charge equalization (cell balancing).

• ALU Folding
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13. Document Revision History for AN 669: Drive-on-Chip
Reference Design
Table 40. Document Revision History

Date Version Changes

2022.05.15 4.0 • Removed support for:
— Intel MAX 10 devices
— Terasic SoCKit
— Falconeye 2 HSMC Motor Control Board
— Multiaxis Motor Control Board

• Added support for Tandem Motion Power 48 V Board
• Updated:

— Compiling the µC/OS-II HPS Software
— Creating and Booting an HPS SD Card Software Image

• Added:
— Creating and Booting a SD Card with both Software Image and Hardware Image
— System Console GUI Upper Pane for the Drive-On-Chip Design Example
— System Console GUI Lower Pane for the Drive-On-Chip Design Example

2020.11.05 3.3 Rebranded to Intel.

2019.11.07 3.2 No changes.

2019.04.18 3.1 Corrected link to iC Haus BISS interface website

June 2015 3.0 • Added support for MAX 10 FPGA devices.
• Updated for Altera Complete Design Suite v15.0
• Removed support for Cyclone IV and Cyclone V (non SoC) devices.
• Removed support for Terasic DE2115 development board
• Updated DSP Builder model.

June 2014 2.1 • Improved Licence Setup instructions.
• Improved Programming the Nios II Device instructions.

February 2014 2.0 • Added support for vibration suppression
• Updated for the Quartus II software v13.1

May 2013 1.3 • Added Cyclone V SoC Development Kit
• Updated for the Quartus II software v13.0

February 2013 1.2 • Added Cyclone V E FPGA Development Kit
• Updated for the Quartus II software v12.1 SP1
• Added BiSS encoder

November 2012 1.1 Added FalconEye.

August 2012 1.0 Initial release.
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